
 

 

 

 

 

 

 

 

 

 

Dobot M1 User Guide 
 

 

 

Issue: V1.5.3 

Date: 2020-01-16 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Shenzhen Yuejiang Technology Co., Ltd



                     Dobot M1 User Guide   

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

i 

Precautions 

Copyright © ShenZhen Yuejiang Technology Co., Ltd 2020. All rights reserved. 

No part of this document may be reproduced or transmitted in any form or by any means 

without prior written consent of Yuejiang Technology Co., Ltd 

 

 

 

 

Disclaimer 

To the maximum extent permitted by applicable law, the products described (including its 

hardware, software and firmware, etc.) in this document are provided AS IS, which may have flaws, 

errors or faults. Yuejiang makes no warranties of any kind, express or implied, including but not 

limited to, merchantability, satisfaction of quality, fitness for a particular purpose and non-

infringement of third party rights. In no event will Yuejiang be liable for any special, incidental, 

consequential or indirect damages resulting from the use of our products and documents. 

Before using our product, please thoroughly read and understand the contents of this document 

and related technical documents that are published online, to ensure that the robotic arm is used on 

the premise of fully understanding the robotic arm and related knowledge. Please use this document 

with technical guidance from professionals. Even if follow this document or any other related 

instructions, Damages or losses will be happened in the using process, Dobot shall not be considered 

as a guarantee regarding to all security information contained in this document. 

The user has the responsibility to make sure following the relevant practical laws and 

regulations of the country, in order that there is no significant danger in the use of the robotic arm. 

 

 

 

Certification specification 

Dobot M1 has been certified as follows. 

    

 

 

 

Shenzhen Yuejiang Technology Co., Ltd 

Address: Floor 9-10, Building 2, Chongwen Garden, Nanshan iPark, Liuxian Blvd, Nanshan 

District, Shenzhen, Guangdong Province, China 

Website: www.dobot.cc 

www.dobot.cc
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Preface 

Purpose 

This Document describes the functions, technical specifications, installation guide and system 

commissioning of Dobot M1, making it easy for users to fully understand and use it. 

Intended Audience 

This document is intended for: 

 Customer Engineer 

 Sales Engineer 

 Installation and Commissioning Engineer 

 Technical Support Engineer 

Change History 

Date Change Description 

2020/01/16  Add example of tray  

 Add I/O trigger recovery mode 

2019/10/25  Modify Cartesian coordinate image 

 Modify end-effector size, robot workspace, and base size images 

 Modify electrical specifications and add internal digital output and input circuit diagrams 

 Modify digital output example 

 Add safeguard stop example 

2019/08/31 The first release 

 

Symbol Conventions 

The symbols that may be founded in this document are defined as follows. 

Symbol Description 

DANGER 

Indicates a hazard with a high level of risk which, if not 

avoided, could result in death or serious injury 

WARNING 

Indicates a hazard with a medium level or low level of 

risk which, if not avoided, could result in minor or 

moderate injury, robotic arm damage 

NOTICE 

Indicates a potentially hazardous situation which, if not 

avoided, can result in robotic arm damage, data loss, or 

unanticipated result 

NOTE Provides additional information to emphasize or 

supplement important points in the main text 
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 Security Precautions 

This topic describes the security precautions that should be noticed when using this product. 

Please read this document carefully before using the robot arm for the first time. This product needs 

to be carried out in an environment meeting design specification, you cannot remold the product 

without authorization, otherwise, it could lead to product failure, and even personal injury, electric 

shock, fire, etc. People who use this product for system design and manufacture must be trained by 

our company, relevant institution, or must have the same professional skills. The installation 

personnel, operators, teaching personnel, programmers and system developers of the robotic arm 

must read this document carefully and use the robot arm strictly according to the regulations of this 

document strictly. 

1.1 General Security 

DANGER 

The robot arm is electrical equipment. Non-professional technicians cannot modify the 

wire, otherwise, it is vulnerable to injury the device or the person. 

 

The following security rules should be followed when using the robot arm for industrial design 

and manufacture. 

 You should comply with local laws and regulations when operating the robotic arm. The 

security precautions in this document are only supplemental to local laws and regulations. 

 The DANGER, WARNING, and NOTICE marks in this document are only 

supplemental to the security precautions. 

 Please use the robot arm in the specified environment scope. If not, exceeding the 

specifications and load conditions will shorten the service life of the product even damage the 

equipment. 

 Please ensure that the robotic arm is operated under security conditions and there is no 

harmful object around the robotic arm. 

 The hazardous area of the robotic arm is its workspace plus 100mm. In order to prevent 

people from entering the work area accidentally, it is necessary to build a safety barrier to 

prohibit people from entering the hazardous area. 

 When the temperature is close to the freezing temperature, the other operations on the 

robotic arm will not be allowed until the robotic arm moves at the rate of 10% or less for more 

than ten minutes to make itself warm up. 

 Highly corrosive cleaning is not suited to cleaning the robotic arm. The anodized 

components are not suitable for immersion cleaning. 

 Please execute a daily inspection and regular maintenance, replace the defective parts in 

time, in order to keep the equipment in working order. 

 Please comply with the relevant laws to deal with the product which is scrapped, and 

protect the environment. 
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 People cannot repair and disassemble the robotic arm without professional training. If 

there is a problem with the robotic arm, please contact Dobot technical support engineer in 

time. 

 Before operating and maintaining the robotic arm, the personnel responsible for the 

installation, operation, and maintenance must be trained to understand the various security 

precautions and to master the correct methods of operation and maintenance. 

 Only trained personnel may commission and set up the robotic arm. 

 Commissioning of the incomplete machine is prohibited until it has been installed in a 

machine and the whole machine complies with the provisions of the Machinery Directive 

(2006/42/EC). 

 The robotic arm may only be operated with the associated standard equipment. Any other 

use of tools is deemed to be inaccurate use. 

 Only authorized personnel who are instructed in work safety must work on the machine. 

 Before the operation, please wear protective clothing, such as antistatic uniform, 

protective gloves, and protective shoes.  

 It is prohibited to modify or remove the nameplates, instructions, icons, and marks on the 

robotic arm and the related equipment. 

 Service Security 

WARNING 

It is necessary to shut off the power supply before installing the robotic arm, to prevent 

any electric shock or malfunction. 

 

The following security rules should be followed when using the robotic arm for installing, 

teaching and programming. 

 Be careful during the robotic arm carrying or installing. Please follow the instructions on 

the packing box to put down the robotic arm gently and place it correctly in direction of the 

arrow. 

 Before operating the robotic arm, please find and understand how to operate the 

emergency stop function, ensure that the robotic arm can be stopped in an emergency. 

 You must connect the cables needed to the robotic arm first, and then power on the robotic 

arm. 

 When operating the robotic arm over the PC, please do not reach out into the workspace 

of the robotic arm, otherwise, it will be vulnerable to injury the device or the person. 

 When the robotic arm is running, please do not plug or unplug the power and 

communication cables at will. 

 Before disconnecting the external equipment from the robotic arm, such as a 3D mouse, 

please make sure that the robotic arm is completely powered off. 

 When powering on the robotic arm for the first time, please check the Z-axis or J3 value 

from M1Studio. If the value is below 10mm, a limitation alarm is generated and meanwhile 
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the red indicator on the base of the robotic arm will be on and this is a normal phenomenon. At 

that point, you need to click J3+ under the Joint coordinate system on the M1Studio page to 

jog the robotic arm to the position where the J3 value is above 10mm, and then the alarm will 

be cleared. 

 When powering on the robot arm for the first time, please ensure that the emergency stop 

switch has been reset (The emergency stop button is released). Otherwise, the robotic arm will 

not work normally. If the emergency stop switch is not opened, please rotate the emergency 

stop button clockwise. The emergency stop button will be released when rotating to 45°. 

 Please DO NOT connect the power cable to the Dobot M1 directly without power 

adapter. Otherwise, the machine will be damaged. 

 In normal use of Dobot M1, please DO NOT enable safeguard stop function at will. 

Otherwise, the scripts cannot be run. 

 Non-professional users are not allowed to replace the driver board. Please DO NOT switch 

the driver boards on different joints. Otherwise, the driver boards or main control board will 

be damaged. If you need to replace the driver board, please contact Dobot technical support 

engineer.  
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 Introduction  

 Overview 

Dobot Master 1st generation robotic arm (Dobot M1 for short) focuses on the light industrial 

market with great potential, and supports teaching, playback, script control, blockly graphic 

programming, laser engraving, 3D printing, vision identity and other functions, which is flexibly 

used in intelligent sorting, circuit board soldering and other automatic production lines, so that it 

can become the sword to solve practical problems for light industrial users, and can also become the 

platform to carry the imagination of the maker. Dobot M1 has the following characteristics. 

 The integrated design of the driver and controller without external controller simplifies 

the process of the initial installation and deployment. 

 The perfect calibration of servo motor, harmonic reducer and kinematic algorithm inside 

Dobot M1 bring out the best of strength and speed. 

 The rated load is 1.5kg, and the repeatability is ±0.02mm. 

 Various I/O and communication interfaces are provided for secondary development. 

 Appearance and Constitute 

Dobot M1 consists of base, Z axis, Rear Arm, Forearm. Figure 2.1 shows the appearance. 

 

Figure 2.1  The appearance of Dobot M1 

 

 Working Principle 
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This topic describes the workspace, principle, size, and technical specifications of Dobot M1. 

 Workspace 

Figure 2.2 shows the workspace. 

 

Figure 2.2  Workspace of Dobot M1 

 

 Coordinate System 

Dobot M1 has two types of the coordinate system, the joint one and the Cartesian one, as shown 

in Figure 2.3 and Figure 2.4 respectively. 

NOTE 

The data shown in Figure 2.3 indicates the mechanical limitation. 
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Figure 2.3  Joint coordinate system 

 

  

Figure 2.4  Cartesian coordinate system 
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 Joint coordinate system: The coordinates are determined by the motion joints. 

Dobot M1 contains four joints. 

 J1, J2, and J4 are the rotating joints, which are located and oriented in the horizontal 

plane. And their axes are parallel to each other. The positive direction of these joints 

is counter-clockwise. 

 J3 is the moving joint, which is used for the movement of the end effector in the 

perpendicular plane. The positive direction of J3 is vertical upward. 

 Cartesian coordinate system: The coordinates are determined by the base. 

 The origin is the axes center of the motor of Rear Arm where Rear Arm is dropped 

to the bottom of the Z-axis screw. 

 The direction of X-axis is perpendicular to the base forward. 

 The direction of Y-axis is perpendicular to the base leftward. 

 The direction of Z-axis is vertical upward, which is based on the right-hand rule. 

 The R-axis is the attitude of the end center relative to the origin of the robotic arm, 

of which the positive direction is counter-clockwise. The R-coordinate is the sum of 

the coordinates of J1, J2, and J4. 

 Arm Orientation 

With two types of the arm orientation (lefty hand orientation and righty hand orientation), 

Dobot M1 can move to nearly any position and orientation within a given work envelope. You 

need to specify the arm orientation when Dobot M1 is moving. If you fail to do so, Dobot M1 

may move following an unexpected path, resulting in interference with peripheral equipment. 

The arm orientations are shown in Figure 2.5 and Figure 2.6.  

 

Figure 2.5 Righty hand orientation 
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Figure 2.6 Lefty hand orientation 

 

 Motion Function 

The motion modes of Dobot M1 include Jogging, Point to Point (PTP), ARC, and CIRCLE. 

2.3.4.1 Jogging Mode 

Jogging mode is to jog Dobot M1 in the Cartesian coordinate system or Joint coordinate 

system. 

NOTE 

This topic describes jogging mode by the GUI operation of M1Studio. 

 

 Cartesian coordinate system mode 

 Click X+, X- and Dobot M1 will move along X-axis in the negative or positive 

direction. 

 Click Y+, Y- and Dobot M1 will move along Y-axis in the negative or positive 

direction. 

 Click Z+, Z- and Dobot M1 will move along Z-axis in the negative or positive 

direction. 

 Click R+, R- and Dobot M1 will rotate along R-axis in the negative or positive 

direction. 

 Joint coordinate system mode 

 Click Joint1+, Joint1- and control the Rear Arm to rotate in the negative or positive 

direction. 

 Click Joint2+, Joint2- and control the Forearm to rotate in the negative or positive 

direction. 

 Click Joint3+, Joint3- and control the Z-axis to move in the negative or positive 

direction. 

 Click Joint4+, Joint4- and control the R-axis to rotate in the negative or positive 
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direction. 

2.3.4.2 Point to Point Mode (PTP) 

PTP mode supports MOVJ, MOVL, and JUMP, which means point to point movement. The 

trajectory of playback depends on the motion mode. 

 MOVJ: Joint movement. From point A to point B, each joint will run from the initial angle 

to its target angle, regardless of the trajectory, as shown in Figure 2.7. 

 

Figure 2.7  MOVL/MOVJ mode 

 

 MOVL: Rectilinear movement. The joints will perform a straight line trajectory from 

point A to point B, as shown in Figure 2.7. 

 JUMP: From point A to point B, The joints will move in the MOVJ mode, of which the 

trajectory looks like a door, as shown in Figure 2.8. 

 Move up to the lifting Height (Height) in the MOVJ mode. 

 Move up to the maximum lifting height (Limit). 

 Move horizontally to a point that is above B by height. 

 Move down to a point that is above B by height, which the height of the point 

is that of point B plus Height. 

 Move down to Point B. 

 A
B

①

②

③
④

⑤

▲

▶ ▶

▼

Height

Limit

 

Figure 2.8  JUMP mode 
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In the JUMP mode, if the starting point or the end point is higher than or equal to Limit, or the 

height that the end effector lifts upwards is higher than or equal to Limit, the trajectory is different 

to that of Figure 2.8. Assuming that point A is the starting point, point B is the end point, Limit is 

the maximum lifting height, and Height is the lifting height. 

 Point A and point B are both higher than Limit, but point A is higher than point B.  

A

Limit
B

 

 

 Point A and point B are both higher than Limit, but point B is higher than point A. 

A
Limit

B

 

 

 Point A is higher than Limit, but point B is lower than Limit. 

A

Limit

B

 

 

 The height of point A is the same as that of point B, but both are higher than Limit. 

A

Limit

B
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 Point A is lower than Limit, but point B is higher than Limit. 

A

Limit

 

 

 The height of point A and point B are both the same as Limit. 

A
Limit

B

 

 

 Point A and point B are both lower than Limit, but point A plus Height and point B plus 

Height are higher than Limit. 

A

Limit

B

 

 

2.3.4.3 ARC Mode (ARC) 

The trajectory of ARC mode is an arc, which is determined by three points (the current point, 

any point and the end point on the arc), as shown in Figure 2.9.  

NOTICE 

In the ARC mode, it is necessary to confirm the starting point with other motion modes, 

and the three points cannot be in a line. 
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Figure 2.9  ARC mode 

 

2.3.4.4 CIRCLE Mode (CIRCLE) 

The CIRCLE mode is similar to the ARC mode and its trajectory is a circle. In the CIRCLE 

mode, it is necessary to confirm the starting point with other motion modes. 

2.3.4.5 Application Scenarios 

The application scenario depends on the trajectory in motion mode, as shown in Table 2.1. 

Table 2.1  Application scenario 

Motion mode Application scenario 

MOVL If the trajectory of playback is required as a straight line, you can choose MOVL 

MOVJ If the trajectory of playback is not required but high speed is required, you can choose 

MOVJ 

JUMP If the movement of two points is required to lift upwards by amount of height, such as 

sucking up, grabbing, you can choose JUMP 

ARC If the trajectory of playback is required as an arc, such as dispensing, you can choose 

ARC 

CIRCLE If the trajectory of playback is required as a circle you can choose CIRCLE 

 

 Technical Specifications 

 Technical Parameters 

Name Dobot M1 

Reach  400mm 

Rated payload  1.5kg 

Maximum 

magnitude 

Type Mechanical limitation Software limitation 

J1 -90°- 90° -85°- 85° 

J2 -135°- 135° -135°- 135° 
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J3  0mm- 250mm 10mm- 235mm 

J4 Unlimited -360°- 360° 

Maximum speed Joint speed of 

Forearm and 

Rear Arm 

180°/s 

Resultant 

speed of the 

Forearm and 

Rear Arm 

2000mm/s 

Speed of Z-

axis 

1000mm/s 

Repeatability ±0.02mm 

Power Power Adapter: 100V-240V AC,50/60Hz 

Dobot M1: 48V DC 

Communication 

interface 

Ethernet, RS-232C 

I/O  22 digital outputs 

 24 digital inputs 

 6 ADC inputs 

Software M1Studio 

 

NOTE 

Mechanical Limitation: Limit the position of Dobot M1 by mechanical parts. 

Software Limitation: For protection, limit the position of Dobot M1 by software. 

 

Generally, the rated payload is available under the rated speed. The over payload will affect the 

robot precision. When an eccentric end effector is mounted on the robot, the inertia force caused by 

eccentric payload cannot be underrated or ignored. Otherwise, the robot will be damaged. When the 

eccentric end effector is mounted, the recommended positional relationship between the load weight 

and the offset amount from the center of the R-axis is shown as Figure 2.10. 
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Figure 2.10  Positional relationship between the load weight and the offset amount from the center of 

the R-axis 

 

 Sizes 

2.4.2.1 Dobot M1 Size 

Figure 2.11 shows the size of Dobot M1. 

NOTE 

Z-axis Motion Range shown in Figure 2.11 indicates the mechanical limitation. 

 

Figure 2.11  Size of Dobot M1  
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2.4.2.2 End-effector Size 

You can install the matching gripper, suction cup, or laser on the end of the Dobot M1 for 

transporting, intelligent sorting and laser engraving. Figure 2.12 shows the size of the end effector 

of Dobot M1. 

 

Figure 2.12 Size of the end-effector 
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 Hardware Installation 

 Environment Requirements 

The operating temperature of Dobot M1 ranges from 5 °C to 40 °C. The operating humidity 

ranges from 5% to 90% (non-condensing). 

 Installing the Base of Dobot M1 

The stability of Dobot M1 depends on the installation of the base of Dobot M1. You can design 

the platform according to the size of the hole of the base and the real environment for fixing Dobot 

M1. The platform must not only bear Dobot M1, but also bear the dynamic force by the maximum 

acceleration. Note the following before installing the platform. 

 Design the platform according to the workspace of Dobot M1, and ensure that Dobot M1 

moves without interference. 

 Keep the platform level which is used to support Dobot M1. 

 Do not put water or other drinks near or on the platform, in order to avoid potential safety 

hazard because of liquid leakage. 

Procedure 

 

 

Figure 3.1 shows the size of hole of the base. 

 

Figure 3.1  Size of the base 

 

 

  (Optional) Installing End Effector 

You can install the matching gripper, suction cup, or laser on the end of the Dobot M1 for 

transporting, intelligent sorting and laser engraving.  
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 Installing Laser Engraving Kit 

Figure 3.2 shows the laser kit. 

 

Figure 3.2  Laser kit 

Procedure 
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Figure 3.3  connect to Forearm I/O interface 

 

 Installing 3D Printing Kit 

Figure 3.4 shows the 3D printing kit. 
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Figure 3.4  3D printing kit 

Procedure 

 

 

 

Figure 3.5  Connect to Forearm I/O interface 
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Press down the lever on the extruder by hand, and push down the filament to the 

bottom via a pulley, as shown in Figure 3.6 and Figure 3.7. 

 

Figure 3.6  Push down the filament (1) 

 

Figure 3.7  Push down the filament (2) 

 

 (Optional) Installing Air Pump 
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It is necessary to install the matching air pump when using the gripper or suction cup for 

grabbing objects. The air pump is controlled over the I/O interface. For details, please see 6.7 

Operating I/O Assistant. The Air pump that we provided is used for debugging I/O interface. 

In real applications, please select a professional one. 

Figure 3.8 shows the air pump. Table 3.1 lists the description of the cables that are shown 

in this figure. 

 

Figure 3.8  Air pump 

NOTE 

The appearance of the air pump depends on the production batch of Dobot M1. However, 

the connection method remains unchanged. 

 

Table 3.1  Cable Description 

Color Description 

Red VCC_24V 

Black PGND 

Yellow OUT1: Control the intake and outtake of the air pump 

Blue OUT2: Control the status of the air pump 
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If the air pump is connected to the base I/O interface. The yellow cable and the blue one are 

connected to the output pins (The corresponding outputs listed in 4.3.2.2 Base I/O Interface are 

DOUT17 and DOUT18) of the base I/O interface. The red one and the black one are connected to 

the VCC_24V pin on the base I/O interface and the PGND pin on the CAN bus interface 

respectively, as shown in Figure 3.9, and you need to tighten them with a straight screwdriver. The 

description in this topic is for reference only. Please choose the appropriate interface to connect the 

air pump. For details, please see 4.3 Interface Description. 

  

Figure 3.9  Air pump connection 

 

NOTICE 

When an air pump is connected to I/O interface, the terminals of air pump cannot be 

exposed to the air, to avoid short circuit. If that happens, you need to cut them to an 

appropriate length. For matching all I/O interfaces, terminals of air pump will be slightly 

longer. Figure 3.10 and Figure 3.11 show the standard and non-standard connection of 

the terminals respectively. 
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Figure 3.10  Standard connection 

 

 

Figure 3.11  Non-standard connection 
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 Electrical Specifications 

The addresses of the I/O interfaces of Dobot M1 are unified. 

 Interface Board 

The interface board of Dobot M1 is located on the back of the base. If the SN number of Dobot 

M1 is DT211812xxx and later numbers, the interface board is shown in Figure 4.1. 

 

Figure 4.1  Base interface description 

 

If the SN number of Dobot M1 is DT211811xxx and earlier numbers, as shown in Figure 4.2. 

 

Figure 4.2 Interface board of Dobot M1 

 

 LED Indicators 

Table 4.1 lists the status of the LED indicators on the interface board and the power adapter.  

Table 4.1 Description of the LED indicators  

Item Description 

Power adapter 

indicator 

The LED indicator is steady on when the power adapter is powered on. 



                     Dobot M1 User Guide 4 Electrical Specifications 

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

28 

Item Description 

System indicator  All the LED indicators are off when the Dobot M1 is powered off 

 Yellow LED indicator: when powering on the Dobot M1, the 

yellow LED indicator in the base is steady on for about 15 seconds 

and then blinks once. It is steady on again for about 5 seconds 

 Green LED indicator: when powered on the Dobot M1, the yellow 

LED indicator in the base is off, the green one is steady on for about 

5 seconds and then is blinking. That means, Dobot M1 is in service 

 Blue LED indicator: The blue one is blinking, indicating that 

Dobot M1 is working in the offline mode 

 Red LED indicator: The red one is steady on, indicating that an 

alarm is generated when the Dobot M1 is running 

 

 Interface Description 

NOTICE 

In this topic, PGND indicates the reference ground corresponding to 24V or 48V, AGND 

indicates the reference ground corresponding to the analog signal, and GND indicates the 

reference ground corresponding to all signals. For details, please see the specific interface 

description. 

 

 Power Adapter Interface 

4.3.1.1 AC Input Interface 

NOTICE 

Figure 4.3 shows the power adapter. For details on how to connect the Dobot M1 to the 

power adapter, please see 5.2.1 Connecting Power Supply. 
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Figure 4.3  Power adapter 

 

Table 4.2  The power adapter input interface description 

No. Name Function Voltage/Current 

1 AC_L L of the AC power 100V-240V AC/2.6A 

2 AC_N N of the AC power  100V-240V AC/2.6A 

3 Earth GND GND 

 

4.3.1.2 DC output Interface 

Table 4.3  The power adapter output interface description 

No. Name Function Voltage/Current 

1 V+ Positive electrode of the 

DC power 

48V DC/5A 

2 V- Negative electrode of the 

DC power 

GND/5A 
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 Body I/O Interface 

4.3.2.1 Power Interface 

Table 4.4 Description of the power interface  

PIN Name Function Voltage/Current 

1 VIN Positive electrode of the 

DC power 

48V DC/5A 

2 PGND Negative electrode of the 

DC power 

GND/5A 

 

4.3.2.2 Base I/O Interface 

Table 4.5  Description of the base I/O interface  

PIN Name Function Voltage/Current 

1 GND Negative electrode of 

power supply 

GND/2A 

2 VCC Positive electrode of 

power supply 

24V/2A (Max) 

3 RS232_RX RS232 acception RS232 level 

4 RS232_TX RS232 transmission RS232 level 

5 STOP2+ Positive electrode of the 

safety input 2, used for 

connecting to emergency 

stop switch 

24V/100mA (Max) 

6 STOP1+ Positive electrode of the 

safety input 1, used for 

connecting to emergency 

stop switch 

24V/100mA (Max) 

7 STOP2- Negative electrode of 

safety input 2, used for 

connecting to emergency 

stop switch 

24V/100mA (Max) 

8 STOP1- Negative electrode of 

safety input 1, used for 

connecting to emergency 

stop switch 

24V/100mA (Max) 

9 DOUT17 Digital output 24V/2A (Max) 

file:///C:/Users/Administrator/AppData/Local/youdao/DictBeta/Application/7.2.0.0703/resultui/dict/result.html
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PIN Name Function Voltage/Current 

10 DOUT18 Digital output 24V/2A (Max) 

11 DIN20 Digital input 24V/100mA (Max) 

12 DIN18 Digital input 24V/100mA (Max) 

13 DIN19 Digital input 24V/100mA (Max) 

14 DIN17 Digital input 24V/100mA (Max) 

 

Figure 4.4 shows the internal digital output circuit diagram and Figure 4.5 shows the internal 

digital input circuit diagram. In Dobot M1, all digital inputs only support NPN external equipment. 

 

Figure 4.4  Internal digital output circuit diagram 

 

 

Figure 4.5  Internal digital input circuit diagram 

4.3.2.3 GND Interface 

Table 4.6  The CAN bus interface description 

PIN Name Function Voltage/Current 
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1 - - - 

2 PGND Negative electrode of 

power supply 

GND/5A 

3 - - - 

4 - - - 

 

4.3.2.4 Forearm I/O Interface 

Figure 4.6 shows Forearm I/O interface and Table 4.7 shows its description. 

 

Figure 4.6  Forearm I/O interface 

 

Table 4.7  The Forearm I/O interface description 

PIN Name Function Voltage/Current 

1 VCC Positive electrode of the 

power supply 

24V/2A (Max) 

2 DOUT19 Digital output 24V/2A (Max) 

3 DOUT20 Digital output 24V/2A (Max) 

4 DOUT21 Digital output 24V/2A (Max) 

5 DOUT22 Digital output 24V/2A (Max) 

6 AIN5 Analog input 0V~5V/100mA (Max) 

7 AIN6 Analog input 0V~5V/100mA (Max) 

8 AGND Negative electrode of the 

power supply 

AGND/1A 

9 - - - 
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10 - - - 

11 DIN21 Digital input 0V,24V/<100mA 

12 DIN22 Digital input 0V,24V/<100mA 

13 DIN23 Digital input 0V,24V/<100mA 

14 DIN24 Digital input 0V,24V/<100mA 

15 GND Negative electrode of the 

power supply 

GND/2A 

 

 External Expansion Interface 

Figure 4.7 shows the DB62 external expansion board and Table 4.8 lists the description. 

 

Figure 4.7  DB 62 external expansion board 
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Table 4.8 The external expansion interface description 

PIN Name Function Voltage/Current 

1 EX_IN9

（DIN9） 

Digital input 24V/100mA (Max) 

2 PGND Negative of the power 

supply 

GND/5A 

3 EX_IN10

（DIN10） 

Reset signal 24V/100mA (Max) 

4 PGND Negative of the power 

supply 

GND/5A 

5 EX_IN11

（DIN11） 

External I/O control signal. 

Namely, the Dobot M1 

activates external I/O 

control function 

24V/100mA (Max) 

6 PGND Negative of the power 

supply 

GND/5A 

7 EX_IN12

（DIN12） 

Continue signal 24V/100mA (Max) 

8 PGND Negative of the power 

supply 

GND/5A 

9 EX_IN13

（DIN13） 

Pause signal 24V/100mA (Max) 

10 PGND Negative of the power 

supply 

GND/5A 

11 EX_IN14

（DIN14） 

Stop signal 

After this signal is 

triggered, the Dobot M1 

will stop offline running 

while the external I/O 

control will remain in force. 

At this point, you can use 

the M1Studio to control the 

Dobot M1 in the Dobot 

mode or trigger DIN 15 to 

make the Dobot M1 run in 

the offline mode again 

24V/100mA (Max) 
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PIN Name Function Voltage/Current 

12 PGND Negative of the power 

supply 

GND/5A 

13 EX_IN15

（DIN15） 

Start signal, for running in 

offline mode 

Before triggering this 

signal, please trigger DIN 

11 first 

24V/100mA (Max) 

14 PGND Negative of the power 

supply 

GND/5A 

15 EX_IN16

（DIN16） 

Digital input 24V/100mA (Max) 

16 PGND Negative of the power 

supply 

GND/5A 

17 ON_OFF+ Positive of the power signal 0V~24V/100mA (Max) 

18 GND Negative of the analog 

power 

AGND/1A (Max) 

19 GND Negative of the analog 

power 

AGND/1A (Max) 

20 GND Negative of the analog 

power 

AGND/1A (Max) 

21 GND Negative of the analog 

power 

AGND/1A (Max) 

22 NC2 Relay K2 Normally Closed AC： 250V/5A 

DC：30V/5A 

23 NO2 Relay K2 Normally Open AC： 250V/5A 

DC：30V/5A 

24 COM2 Common terminal AC： 250V/5A 

DC：30V/5A 

25 GND_EMC Earth ground GND/5A 

26 FPGA_OUT1

（DOUT11） 

Digital output 24V/2A (Max) 

27 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

28 FPGA_OUT2 Digital output 24V/2A (Max) 
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PIN Name Function Voltage/Current 

（DOUT12） 

29 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

30 FPGA_OUT3

（DOUT13） 

Digital output 24V/2A (Max) 

31 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

32 FPGA_OUT4

（DOUT14） 

Digital output 24V/2A (Max) 

33 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

34 FPGA_OUT5

（DOUT15） 

Digital output 24V/2A (Max) 

35 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

36 FPGA_DOUT6

（DOUT16） 

Digital output 24V/2A (Max) 

37 VCC_24V Positive of the power 

supply 

24V2A (Max) 

38 DAC_OUT1 Analog output, reserved - 

39 GND Negative of the analog 

power 

AGND/1A (Max) 

40 DAC_OUT2 Analog output, reserved - 

41 GND Negative of the analog 

power 

AGND/1A (Max) 

42 ON_OFF- Negative of the power 

signal 

0V~24V/100mA (Max) 

43 IN_A/D1

（AIN1） 

Analog input 0V~10V/100mA (Max) 

44 IN_A/D2

（AIN2） 

Analog input 0V~10V/100mA (Max) 

45 IN_A/D3

（AIN3） 

Analog input 0V~10V/100mA (Max) 

46 IN_A/D4 Analog input 0V~10V/100mA (Max) 
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PIN Name Function Voltage/Current 

（AIN4） 

47 EX_A1+ Signal input for A phase of 

external encoder1, reserved 

- 

48 EX_A1- Inversion signal input for A 

phase of external encoder1, 

reserved 

- 

49 EX_B1+ Signal input for B phase of 

external encoder1, reserved 

- 

50 EX_B1- Inversion signal input for B 

phase of external encoder1, 

reserved 

- 

51 EX_OUT1

（DOUT1） 

Digital output 24V/2A (Max) 

52 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

53 EX_OUT2

（DOUT2） 

Digital output 24V/2A (Max) 

54 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

55 EX_OUT3

（DOUT3） 

Digital output 24V/2A (Max) 

56 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

57 EX_OUT4

（DOUT4） 

Digital output 24V/2A (Max) 

58 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

59 EX_OUT5

（DOUT5） 

Digital output 24V/2A (Max) 

60 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

61 EX_OUT6

（DOUT6） 

Digital output 24V/2A (Max) 

62 VCC_24V Positive of the power 

supply 

24V/2A (Max) 
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PIN Name Function Voltage/Current 

63 EX_OUT7

（DOUT7） 

Running status signal 24V/2A (Max) 

64 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

65 EX_OUT8

（DOUT8） 

Alarm signal 24V/2A (Max) 

66 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

67 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

68 PGND Negative of the power 

supply 

GND/5A 

69 CAN2_H CAN bus, reserved - 

70 CAN2_L CAN bus, reserved - 

71 VCC_5V Positive of the power 

supply 

5V/2A 

72 EX_A2+ Signal input for A phase of 

external encoder2, reserved 

- 

73 EX_A2- Inversion signal input for A 

phase of external encoder2, 

reserved 

- 

74 EX_B2+ Signal input for B phase of 

external encoder2, reserved 

- 

75 EX_B2- Inversion signal input for B 

phase of external encoder2, 

reserved 

- 

76 EX_IN1

（DIN1） 

Digital input 24V/100mA (Max) 

77 PGND Negative of the power 

supply 

GND/5A 

78 EX_IN2

（DIN2） 

Digital input 24V/100mA (Max) 

79 PGND Negative of the power 

supply 

GND/5A 

80 EX_IN3 Digital input 24V/100mA (Max) 
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PIN Name Function Voltage/Current 

（DIN3） 

81 PGND Negative of the power 

supply 

GND/5A 

82 EX_IN4

（DIN4） 

Digital input 24V/100mA (Max) 

83 PGND Negative of the power 

supply 

GND/5A 

84 EX_IN5

（DIN5） 

Digital input 24V/100mA (Max) 

85 PGND Negative of the power 

supply 

GND/5A 

86 EX_IN6

（DIN6） 

Digital input 24V/100mA (Max) 

87 PGND Negative of the power 

supply 

GND/5A 

88 EX_IN7

（DIN7） 

Digital input 

When the safeguard stop 

function is enabled, this 

interface is used for 

Safeguard Input 0 

24V/100mA (Max) 

89 PGND Negative of the power 

supply 

GND/5A 

90 EX_IN8

（DIN8） 

Digital input 

When the safeguard stop 

function is enabled, this 

interface is used for 

Safeguard Input 1 

24V/100mA (Max) 

91 PGND Negative of the power 

supply 

GND/5A 

92 PGND Negative of the power 

supply 

GND/5A 

93 VCC_24V Positive of the power 

supply 

24V/2A (Max) 

94 RS-485_A RS485A bus, reserved - 

95 RS-485_B RS485B bus, reserved - 
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PIN Name Function Voltage/Current 

96 GND Negative of the analog 

power 

AGND/1A (Max) 

97 NC1 Relay K1 Normally Closed AC： 250V/5A 

DC：30V/5A 

98 NO1 Relay K1 Normally Open AC： 250V/5A 

DC：30V/5A 

99 COM1 Common terminal AC： 250V/5A 

DC：30V/5A 

100 GND_EMC Earth ground GND/5A 

 

 

NOTICE 

 In order to improve the sampling accuracy of analog signal, it is suggested to use 

AGND for reference ground. 

 DOUT9 and DOUT10 are used to control relay K1 and K2 respectively, which are 

internal encapsulated interfaces. If you use a relay for power supply or other 

applications, you can use the COM, NC, NO interfaces directly on the external 

expansion board after connecting it to the Dobot M1. If you have to debug the relay 

K1 and K2, you can debug OUT09 and OUT10 on the M1Studio > I/O Assistant 

page. For details, please see 6.10.2.3 Example of Relay Connection 

 All input and output interfaces of the Dobot M1 only can be used for signal control 

and cannot be regarded as a power supply. You can use relays on the external 

expansion board for power supply. Take the relay K1 as an example, the circuit 

diagram is shown in Figure 4.8. 
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Figure 4.8  Circuit diagram 

 

 Communication Interface 

4.3.4.1 Ethernet Interface 

Dobot M1 can connect to a PC over the standard RJ45 Socket interface, using TCP/IP protocol. 

4.3.4.2 RS-232 Interface 

Dobot M1 can connect to a PC over standard the RS-232 interface. 
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 Installation and Commissioning 

 Installing Software 

The main software for Dobot M1 is M1Studio. You can use playback, script control, 3D 

printing, etc. 

 Environment Requirements 

The supported OSs are as follows. 

 Win7 

 Win8 

 Win10 

 Obtaining M1Studio Software Package 

Before operating the Dobot M1, please download the correct version of the M1Studio. The 

path is www.dobot.cc/downloadcenter/dobot-m1.html#most-download. 

 Installing M1Studio 

Prerequisites 

You have obtained the M1Studio software. 

Procedure 

 

If the directory containing decompressed M1Studio files is E:\M1Studio. Please 

replace the directory based on site requirements. 

 

The Select Setup Language page is displayed 

 

 

 

https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
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Figure 5.1  The M1Studio installation GUI 

 

 

 

After 40 seconds later, the FTDI CDM Drivers page is displayed, as shown in Figure 

5.2. 

 

Figure 5.2  FTDI CDM Drivers GUI 
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 Verifying Installation 

Please double-click the M1Studio after installation. If the M1Studio can be started, the 

installation is successful. 

 Troubleshooting 

If the M1Studio is not running, you need to install all VC++ libraries in the C:\Program 

Files\M1Studio\attachment directory, as shown in Figure 5.3. 

C:\Program Files\M1Studio indicates the installation directory of M1Studio, please replace 

the installation directory based on site requirements. 

 

Figure 5.3 The VC++ libraries 

 Connecting Cables 

 Connecting Power Supply 

Figure 5.4 shows the power supply cables and power adapter. 

 

Figure 5.4  Power cables and power adapter 

The input and output interfaces of the power adapter are shown in Table 5.1 and Table 5.2. 
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Table 5.1  The power adapter input interface description 

No. Name Function Voltage/Current 

1 AC_L L of the AC power 100V-240V AC/2.6A 

2 AC_N N of the AC power  100V-240V AC/2.6A 

3 Earth Earth GND 

 

Table 5.2  The power adapter output interface description 

No. Name Function Voltage/Current 

1 V+ Positive electrode of the 

DC power 

48V DC/5A 

2 V- Negative electrode of the 

DC power 

GND/5A 

 

Procedure 
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Figure 5.5  Connect power supply input cable to power adapter 

 

NOTICE 

If the type of the AC power cable is America-standard, please connect the G pin on the 

AC power cable to the Ground pin on the power adapter, the W pin to the N pin, and the 

Z pin to the L pin. 
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Figure 5.6  Connect to Dobot M1 

 

 

 Connecting Emergency Stop Switch 

Before operating the Dobot M1, please connect it to the emergency stop switch to ensure that 

the Dobot M1 can be stopped immediately during running. 

When powering on the Dobot M1 for the first time, please ensure that the emergency stop 

switch has been reset (The emergency stop button is released). Otherwise, the robotic arm will not 

work normally. If the emergency stop switch is not opened, please rotate the emergency stop button 

clockwise. The emergency stop button will be released when rotating to 45°. 

Procedure 

Please connect the terminal block connector with the emergency stop switch to the base I/O 

interface, and you need to tighten the terminal block connector with a straight screwdriver as shown 

in Figure 5.7 and Figure 5.8. 

 

Figure 5.7  Connection between Dobot M1 and the emergency stop switch (1) 
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Figure 5.8  Connection between Dobot M1 and the emergency stop switch (2) 

 

 Connecting Serial Port 

Prerequisites 

The USB to DB9 adapter cable has been obtained. One end is a standard USB port, the other 

end is a 9-pin serial port. 

If the SN number of Dobot M1 is DT211811xxx and earlier numbers, please prepare the USB 

to DB9 adapter cable by yourself. Please check the SN number on the M1Studio > Help > About 

M1Studio page. 

NOTICE 

If you have connected a Dobot M1 to a PC with the USB to DB9 adapter cable, you 

cannot connect them with a network cable. Choose one of the connection methods. 

 

Procedure 
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Figure 5.9  Serial port connection (1) 

 

Figure 5.10  Serial port connection (2) 
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After startup, you can check the corresponding serial information from the serial 

drop-down list on the upper left pane of the M1Studio page and click Connect, as 

shown in Figure 5.11. 

  

Figure 5.11  Serial information of M1Studio 

 

NOTE 

After the Dobot M1 is connected to M1Studio, you can set Dobot M1’s name on the 

M1Studio > Tools > Other… page, as shown in Figure 5.12. Please disconnect 

M1Studio from Dobot M1 after setting the Dobot M1’s name, and the Dobot M1’s name 

with serial port or IP address will be displayed on the serial drop-down list, as shown in 

Figure 5.13. If the Dobot M1’s name is not displayed, please click . 

  

Figure 5.12  Set Dobot M1’s name 

  

Figure 5.13  Display the serial port or IP address 
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 Connecting Network Cable 

In addition to the USB to serial line, you can also use a network cable to connect Dobot M1 

and PC, but both connection ways cannot be supported at the same time, to avoid connection failure. 

The IP addresses of Dobot M1 and PC must be in the same network segment when connecting them 

with the network cable. 

NOTICE 

If you have connected a Dobot M1 to a PC with the USB to DB9 adapter cable, you 

cannot connect them with a network cable. Choose one of the connection methods. 

 

5.2.4.1 Connecting directly 

This topic describes how to connect the Dobot M1 to the PC with a network cable directly and 

a PC can only control single Dobot M1. The connection is shown in Figure 5.14. 

 

Figure 5.14  Direct connection 

 

 If the SN number of Dobot M1 is DT211812xxx and later numbers, please connect them 

as the flowing steps. Please check the SN number on the M1Studio > Help > About M1Studio 

page. 

xxx is a random number, please replace it based on site requirements. 
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The forced configuration page is displayed. 

 

NOTICE 

 Please make sure that the IP address of PC belongs to class C networks when 

configuring the IP address. Otherwise, the forced configuration will fail. 

Class C IP addresses range: 192.0.0.0 - 223.255.255.255. Default subnet mask: 

255.255.255.0. 

 Forced configuration function is recommended only when a PC controls a Dobot 

M1. As a PC controls multiple Dobot M1 simultaneously, all the IP addresses will 

be modified when you modify one of IP addresses by forced configuration. 

 If the A9 firmware version is 02005900 or earlier version, the DHCP function will 

be enabled automatically, resulting in that IP address of Dobot M1 may be changed 

after restarting the Dobot M1. You need to unselect Dynamic Host Configuration 

Protocol (DHCP) on the Dobot M1 IP Address Setting page. 

 If the A9 firmware version is 02006000 or later version, the DHCP function will be 

disabled automatically 

  

Figure 5.15  Forced configuration 

 

After closing the forced configuration page, you can check the corresponding IP 
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address from the serial drop-down list on the upper left pane of the M1Studio page 

and click Connect, as shown in Figure 5.16. 

  

Figure 5.16  IP address information 

 

 If the SN number of Dobot M1 is DT211811xxx and earlier numbers, please connect them 

as the flowing steps. 

If the local IP address, subnet mask of the PC are 192.168.1.10, 255.255.255.0 

respectively. You can run the command ipconfig /all on the CMD console window to view 

the IP information of the PC. 

NOTICE 

 Please make sure that the PC address of PC belongs to class C networks when 

configuring the IP address. Otherwise, the configuration will fail. 

Class C IP addresses range: 192.0.0.0 - 223.255.255.255. Default subnet mask: 

255.255.255.0. 

 The IP addresses of Dobot M1and the PC must be on the same network segment 

without conflict. The subnet masks of them must be the same. 

 If the SN number of Dobot M1 is DT211811xxx and earlier numbers, the forced 

configuration is not supported. You have to configure the IP address as the following 

steps. If the forced configuration function is required, you must configure IP address 

as the following steps and then update A9 firmware to the 02005800 version or later 

versions. For details, please see 6.9.2 Upgrading Firmware. 

 

 

If Connect turns to Disconnect, the connection is successful. 

 

The Dobot M1 IP Address Setting page is displayed. 

 

 

If Network Status of Dobot M1 turns to Connected to LAN, the modification is 

successful. 
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5.2.4.2 Connecting Via Router 

This topic describes how to connect the PC to the Dobot M1 with a router and a PC can control 

multiple Dobot M1 simultaneously. 

NOTICE 

Forced configuration function is recommended only when a PC controls a Dobot M1. As 

a PC controls multiple Dobot M1 simultaneously, all the IP addresses will be modified 

when you modify one of IP addresses by forced configuration. 

 

Prerequisites 

The PC has been connected to a router. 

Procedure 

 

 

 

Figure 5.17  Connect via router 

 

 

You can check the corresponding IP address from the serial drop-down list on the 

upper left pane of the M1Studio page and click Connect, as shown in Figure 5.18. 
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Figure 5.18  IP address information 

 

Abnormal Handling 

If the IP address is not displayed on the upper left pane of the M1Studio page after powering 

on the Dobot M1, please obtain the IP address as the following steps. 

 

If Connect turns to Disconnect, the connection is successful. 

 

 

 

 

 System Commissioning  

The origin and other settings of Dobot M1 have been set by default, Dobot M1 can be directly 

put in use. After Dobot M1 is installed and the cables connected are checked, the system 

commissioning can be performed. 

 Debugging Dobot M1 

Prerequisites 

 You have launched the M1Studio. 

 You have connected the Dobot M1 to the PC over a serial cable or a network cable. 

 You have connected the Dobot M1 to the emergency stop switch. 

Procedure 

 

When powering on the Dobot M1, the yellow LED indicator in the base is steady on 

for about 15 seconds, and then blinks once. It is steady on again for about 5 seconds, 

which indicates that the Dobot M1 is being started. 

After the yellow LED indicator in the base is off, the green one is steady on for about 

5 seconds, and then is blinking, which indicates that the Dobot M1 is in service. 

NOTICE 

When first powering on the robotic arm, please check the Z-axis or J3 value from 

M1Studio. If the value is below 10mm, a limitation alarm is generated and meanwhile 

the red indicator on the base of robotic arm will be on, this is a normal phenomenon. At 

that point, you need to click J3+ under the Joint coordinate system to jog the robotic arm 
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to the position where the J3 value is above 10mm, and then the alarm will be cleared. 

 

If Connect turns to Disconnect, the connection is successful, and Dobot M1 can be 

controlled by M1Studio. 

  

Figure 5.19  The successful Connection 

 

NOTICE 

 You can connect a Dobot M1 to a PC over a network cable, then select the 

corresponding IP address from the serial drop-down list on the M1Studio page and 

click Connect. For details, please see 5.2.4 Connecting Network Cable. 

 M1Studio can be connected to Dobot M1 only when the Dobot M1 is in the Dobot 

Mode. You can check the current mode of Dobot M1 on the Tools > Web 

Management page, as shown in Figure 5.20. For details, please see 6.9 Operating 

Web Management. 

 

 

Figure 5.20  Status of Dobot M1 

 

 Debugging the Power of Dobot M1 

Prerequisites 

 You have powered on the Dobot M1. 

 You have connected the Dobot M1 to an emergency stop switch. 
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Procedure 

Hold down the power button in the base of Dobot M1 for about 5 seconds, and then release the 

button. If all LED indicators are off and the Dobot M1 moves down automatically, the Dobot M1 is 

powered off successfully. 

NOTICE 

You cannot hold down the power button to power off Dobot M1 until Dobot M1 is in the 

running state (when the green LED indicator is blinking). If the Dobot M1 fails to be 

started, you must force to power off the Dobot M1. 

 

 Debugging Emergency Stop Function 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

Procedure 

 

 

 

Figure 5.21  Emergency stop 

 

Dobot M1 is stopped immediately with an alarm about emergency stop and the red 

LED indicator on the base is on, which indicates that the emergency stop function is 

normal. 
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The emergency stop button is released when rotating to 45°, which indicates the 

stopped status is cleared. 

 

 

Figure 5.22 Alarm tip 

 

 

Figure 5.23  Alarm tab 

 Debugging Disabling Function 

You can disable the motor of Dobot M1 to make it in the disabled state, and then move the 

Dobot M1 by hand. 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 
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Procedure 

 

 

Figure 5.24  Disabling Dobot M1 

 

If  turns to  and the Dobot M1 moves down automatically, 

the motor of Dobot M1 is in the disabled state. 

 

If Dobot M1 can be moved by hand, the disabling function is OK. 

 Debugging Motion Function 

For details about motion functions supported by Dobot M1, please see 2.3.4 Motion Function. 

5.3.5.1 Debugging Jogging Function 

Prerequisites 

 The Dobot M1 has been powered on. 
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 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

Procedure 

This section uses Cartesian coordinates as an example to describe how to debug jogging 

function. The procedure for debugging Joint coordinates is similar to that for debugging Cartesian 

coordinates. You need to select Joint on the Operation Panel page, and then Click J1+, J1-, J2+, 

J2-, J3+, J3-, J4+, and J4- to jog Dobot M1. 

 

 

Figure 5.25  Cartesian coordinate mode 

 

 

The jogging velocity is the maximum velocity multiplying the corresponding 

percentage. 
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The jogging acceleration is the maximum acceleration multiplying the corresponding 

percentage. 

 

You can click Y+, Y-, Z+, Z-, R+, and R-, to make the Dobot M1 jog along the Y, Z, 

or R axis in the negative or positive direction. 

5.3.5.2 Debugging Playback Function 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

Procedure 

This section uses the MOVL mode as an example to describe how to debug playback function. 

You can choose other modes such as MOVL, MOVJ, ARC, or CIRCLE. For details on how to save 

points in ARC and CIRCLE mode, please see 6.1.3 Saving Point in ARC Mode. 

 

 

The Playback page is displayed. 

 

 

 

Vel and Jerk on the Playback page indicate the velocity ratio and the jerk ratio of 

the movement when implementing playback respectively. The playback velocity is 

the maximum velocity multiplying the corresponding percentage. The playback jerk 

is the maximum jerk multiplying the corresponding percentage. 

 

 

 

Also, you can save points by activating Enable Hand Hold Teach, the details are as follows. 
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 Debugging Homing Function 

After parts (motors, reduction gear units, battery, etc.) have been replaced or the robotic arm 

has hit the workpiece, the origin of the Dobot M1 will be changed. You need to operate the homing 

procedure after resetting the origin. 

Dobot M1 has installed homing switches near the J1, J2 and J3 limitation position respectively. 

When the Dobot M1 moves to the limited position with a signal triggered by the homing switch, the 

Dobot M1 will move backward at low speed and then stop moving after separating from the homing 

switch, which indicates that the Dobot M1 has moved to the homing point. At the same time, an 

alarm about limitation is generated, you need to jog the Joint to clear the alarm. 

NOTICE 

 Only the Dobot M1 of which SN number is DT2118xxxxx and later numbers has 

installed the homing switch. If not, this procedure is not supported. 

xxx indicates the random number, please replace it based on site requirements. 

 Please make sure that the A9 firmware version is 02005800 or later, that the Dobot 

firmware version is 1.3.0 or later, that the driver firmware version is 1.3.2 or later 

before executing the homing procedure. Otherwise, a limitation alarm will be 

triggered when executing the homing procedure, resulting in homing failure. The 

Dobot M1 firmware versions can be viewed on the M1Studio > Help > About 

M1Studio page. If the related versions are too low, please upgrade them. For details, 

please see 6.9.2 Upgrading Firmware. 

 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

Procedure 

DANGER 

Please DO NOT click Initialization.exe when executing the homing procedure. 

Otherwise, the Dobot M1 may move following an unexpected path, resulting in 

interference with peripheral equipment. 

 

Please select Tools > Home on the M1Studio page, and Dobot M1 will move automatically 

according to the following steppes. 
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After the homing procedure is completed, the coordinate of the homing point is shown in Figure 

5.26. If the coordinate you get is quite different from Figure 5.26, it indicates that the homing 

procedure is failed, please re-execute again. 

 

Figure 5.26  Homing point 

 

 Debugging Initial Position 

In Dobot M1 system, initial position can be user-defined.  You can set it and make robot move 

to this position based on site requirements. 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

Proced 

 

The Other Setting page is displayed. 

 

Please make sure that the intial position is in the workspace of the Dobot M1 without 

singularity. 



                     Dobot M1 User Guide 5 Installation and Commissioning 

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

64 

  

Figure 5.27  Set initial position 

 

 

 

Now, Dobot M1 will move to the set initial position. 

NOTE 

If the initial position is not set, Dobot M1 will move to the default position which is set 

by M1Studio after clicking InitialPose. 



                     Dobot M1 User Guide 6 Operation 

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

65 

 Operation 

 Instructions for M1Studio 

 Module Description 

Dobot M1 supports teaching, playback, script control, and Blockly graphics programming. You 

can use the M1Studio to control a Dobot M1. Table 6.1 lists the corresponding applications on the 

M1Studio page. 

On the M1Studio page, the Playback and Script tabs are opened by default. If you need to 

open Blockly or I/O Assistant, please select the corresponding option on the Tools menu of the 

M1Studio page. 

Table 6.1  The module description of M1Studio GUI 

Module Function  

Playback Teach the Dobot M1 how to move and then record the movement to make the Dobot M1 

accomplish the recorded movements. 

Blockly Control the Dobot M1 by graphics programming. You can program through a puzzle 

interface which is intuitive and easy to understand. 

Script Control the Dobot M1 by the scripting language. 

I/O Assistant Debug the I/O interface that used 

Web Management Execute the saved points lists in the offline mode, and upgrade the firmware. 

 

 Alarms Description 

If teaching or saving point is incorrect, for example, the Dobot M1 moves to where a point is 

at a limited position or a singular position, the Dobot M1 will generate an alarm. For details, please 

see Table 6.2. When an alarm is generated, the red LED indicator on the base will be on. 

NOTICE 

 Singular point: If the directions of the joint1 and joint2 are collinear, the resultant 

velocity of joint1 and joint2 is not in any direction, but in the direction of joint1 

(joint2). Namely, the degrees of freedom of Dobot M1 are degraded. The singular 

point is at the position where joint2 is located at ±10°. In JUMP and MOVJ mode, 

the movement of Dobot M1 is joint movement, Dobot M1 will not generate an alarm 

about singular point. 

 Generally, if you save a point where an alarm is generated when implementing 

jogging, the saved point is unavailable. You need to jog Dobot M1 towards the 

opposite direction under the Joint coordinate system to clear the alarm, and then 

save the point. However, if an alarm about singular point is generated when 

implementing jogging, the saved point is available in JUMP and MOVJ mode. 
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 In the MOVJ or JUMP mode, if the two points are the same, only different in arm 

orientations, J1 or J4 may be limited when moving the Dobot M1, resulting in an 

alarm generated. You need to modify and resave these points and then clear the 

alarm manually. 

 

Table 6.2  Alarm Description 

Alarm Condition Clear method 

Jogging 

The Joint axis is limited Jog the limited Joint towards the opposite direction, and 

the alarm will be automatically cleared 

The Cartesian axis is limited Jog the Joints towards the opposite direction, and the 

alarm will be automatically cleared 

The point is at the singular position when clicking 

the Cartesian coordinate buttons 

Jog joint2, and the alarm will be automatically cleared 

Playback 

The starting point or the end point is a singular point 

in the MOVL mode 

Clear the alarm manually and modify the point 

A point in the trajectory is a singular point in the 

MOVL mode 

Clear the alarm manually and modify the point  

Modify the arm orientation of the saved point in the 

MOVL mode  

Clear the alarm manually and modify the arm orientation 

The middle point or the end point is a singular point 

in ARC mode 

Clear the alarm manually and modify the point 

A point in the trajectory is a singular point in the 

ARC mode 

Clear the alarm manually and modify the point 

Any two of the three points of the arc coincide in the 

ARC mode 

Clear the alarm manually and modify the point 

The three points of the arc are in a line in the ARC 

mode 

Clear the alarm manually and modify the point 

The trajectory is out of range of the workspace in all 

modes 

Clear the alarm manually and modify the point 

The joint is limited in all modes Clear the alarm manually and modify the point 

The method on how to clear the alarm is shown as follows. 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to the PC successfully. 
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 The Dobot M1 has been connected to the emergency stop switch. 

Procedure 

 

The Alarm Log is displayed. 

 

Figure 6.1 Alarm tips 

 

 

 

Figure 6.2  Alarm GUI 

 

Table 6.3 shows the description of the alarm button. 
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Table 6.3  Alarm button description 

Button  Description 

History Whether to display historical alarms. 

 If the status of History is , all historical alarms will be displayed. 

 If the status of History is , only the current alarm will be displayed. 

AutoScroll Whether to scroll the alarm information automatically 

If the status of AutoScroll is , the alarm information will be scrolled 

automatically 

 

 

If there are no alarm tips on the M1Studio page, the alarm has been cleared. 

 Saving Point in ARC Mode 

Different from PTP, the trajectory of ARC is an arc, you need to save three points to complete 

the arc trajectory. The method to save points in CIRCLE is the same as that of ARC. 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to the PC successfully. 

 The Dobot M1 has been connected to the emergency stop switch. 

Procedure 

NOTICE 

You need to use other motion modes to confirm the starting point of the arc trajectory 

because the middle point and the end point only can be confirmed in ARC mode. When 

saving points in the ARC mode, please pay attention to the following tips to avoid 

generating an alarm. 

 Any two of the three points of the arc cannot coincide.  

 The three points of the arc cannot be in a line. 

 The arc trajectory cannot be out range of the workspace 

 The arm orientations in ARC and other modes that confirms the starting point 

should be the same. Otherwise, the Dobot M1 will not work. 

 

If the three points of the arc trajectory are point A, point B, and point C respectively, and point 

A is the starting point, point C is the end point, as shown in Figure 6.3. 
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Figure 6.3  Arc trajectory 

 

 

 

 

 

 

 

 

 

NOTICE 

You cannot set the pause time when point A moves to point B. Otherwise, Dobot M1 will 

not work. 
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Figure 6.4  Information of saved points in ARC 

 

 Saving point in JUMP Mode 

From point A to point B in JUMP mode: 

 If point A and point B are only different in Z-axis, and the arm orientations of them are 

the same, Dobot M1 will not work. 

 If point A and point B are the same, only different in arm orientations, for example, the 

arm orientation of point A is left, and that of point B is right, point A moves to point B as the 

right hand posture, while the terminal coordinate relative to the origin stays constant. 

 Operating Teaching and Playback 

 Basic Operation 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to the PC successfully. 

 The Dobot M1 has been connected to the emergency stop switch. 

 The air pump and the suction cup need to be installed when you suck up objects over the 

teaching and playback function. For details on how to connect with an air pump, please see 3.4 

(Optional) Installing Air Pump. 

Application Scenario 

If you want to use the Dobot M1 to transport, intelligent sort, write and draw, the teaching and 

playback function of Dobot M1 can help you to complete. This section uses the suction cup as the 

end effector to describe how to operate. 

Procedure 

 

 Select Cartesian from Cartesian drop-down list on the Operation Panel page, and 

click the Cartesian coordinate buttons. 

 Select Joint from Cartesian drop-down list on the Operation Panel page, and click 
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the Joint coordinate buttons. 

 Click the  icon of Motor on the Operation Panel page, and jog the 

Dobot M1 by hand. 

NOTICE 

 If you want to jog the Dobot M1 by hand when implementing jogging, please click 

 to make the motor of Dobot M1 in the disabled state. If you want to 

move Dobot M1 by clicking the coordinate buttons on the Operation Panel page, 

please click  to make the motor in the enabled state.  

 If an axis is limited or a point is at the singular position when implementing jogging, 

an alarm will be generated. For details about alarm description, please see Table 6.2. 

If you save a point after an alarm is generated, the saved point is unavailable. You 

need to jog the Dobot M1 to clear the alarm, and then save the point again. However, 

if an alarm about singular point is generated when implementing jogging, the saved 

point is available in JUMP and MOVJ mode. 

 

 

 

The Playback page is displayed. 

 

NOTE 

The motion mode in this topic is for reference only. You can choose other motion modes 

based on site requirements. If you use the ARC mode, for details on how to saving points 

in ARC, please see 6.1.3 Saving Point in ARC Mode. 

 

 

Figure 6.5 Choose motion mode 
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The saved point information of which Type is JUMP is displayed on the left pane of 

the Playback page, as shown in Figure 6.6. 

 

Figure 6.6  The coordinate display 

 

 

Figure 6.7 Motion command setting 
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NOTICE 

In the JUMP mode, if lifting Dobot M1 to the maximum height is not necessary after 

lifting to a certain height, please unselect Use Limit. 

 

 

The saved point information of which Type is Wait is displayed on the left pane of 

the Playback page. 

 

NOTICE 

Supposing that we use DOUT17, DOUT18 on the base I/O interface to control the state 

of the air pump. DOUT17 controls the intake and outtake of the air pump. DOUT18 controls 

the startup and shutdown. The description in this topic is for reference only, the outputs 

depend on the I/O interface used. Please replace the outputs based on site requirements. 

 Select Output on the Add I/O Command pane of the Playback page. 

The saved point information of which Type is Output is displayed on the left 

pane of the Playback page.  

 Select the saved point of which Type is Output on the left pane of the Playback 

page, and double-click Content. 

The I/O Command Setting page is displayed. 

 Select OUT17 from the I/O drop-down list on the I/O Command Setting page, 

and select 24V, then click Add. 

 Add OUT18, and select 24V, then click OK. 

The relevant I/O information of which Type is Output is displayed on the left 

pane of the Playback page. Right-click on the line and select RunSelected on 

the context menu, to make the air pump in service, and the object will be sucked 

up by the Dobot M1. 

 

 

 

NOTICE 

Supposing that we use DOUT17, DOUT18 on the base I/O interface to control the state 

of air pump. DOUT17 control the intake and outtake of air pump. DOUT18 control the 

startup and shutdown. The description in this topic is for reference only, the outputs 

depend on the I/O interface used. Please replace the outputs based on site requirements. 
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 Select Output on the Add I/O Command pane of the Playback page. 

The saved point information of which Type is Output is displayed on the left 

pane of the Playback page.  

 Select the saved point of which Type is Output on the left pane of the Playback 

page, and double-click Content.  

The I/O Command Setting page is displayed. 

 Select OUT17 from the I/O drop-down list on the I/O Command Setting page, 

and select 24V, then click Add. 

 Add OUT18, and select 0V, then click OK. 

The relevant I/O information of which Type is Output is displayed on the left 

pane of the Playback page. Right-click on the line and select RunSelected on 

the context menu, and the object will be released by the Dobot M1. 

NOTE 

This topics only describes a trajectory as an example. You can implement multiple 

trajectories. For details, see Step 1 to Step 10. 

 

 

The Save Playback File page is displayed. 

 

 

 Other Function Description 

You can perform subsequent operations on the Playback page. 

 Select Enable Hand Hold Teach on the Playback page, the Add Motion Command 

button will be unavailable. You can hold down the button under the Rear Arm to save a point 

after jogging the Dobot M1 on the Operation Panel page or moving the Dobot M1 by hand. 

For details, please see 5.3.5.2 Debugging Playback Function. 

 Set the loop number of the saved point when implementing playback. The maximum value 

is 9999. You can also select Infinite Loop to make the Dobot M1 in the infinite loop state when 

implementing playback according to the saved points list, as shown in Figure 6.8. 

 

Figure 6.8  The loop number of the saved points list 

 

 Before saving a point, you can select the location of the added point on the right pane of 

the Playback page, as shown in Figure 6.9 
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Figure 6.9  Overwrite the current saved point 

 

Table 6.4 lists the location description of a saved point.  

Table 6.4  Description of the location of a saved point 

Insert Location Description 

Add At Last Add a new point after the last saved point. 

Insert Before Selected Row Insert a point before the current saved point 

OverWrite Selected Row Overwrite the current saved point 

 

 Select a saved point and double-click the parameters on the line to modify the relevant 

information. The saved point information is shown in Figure 6.10. 

 

 

Figure 6.10  The saved point information 
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Table 6.5 Parameter Description of the saved point 

Parameter Description 

Type The command type of Dobot M1 

Value: 

 JUMP 

 MOVJ 

 MOVL 

 ARC 

 CIRCLE: The method to save points in the CIRCLE mode is the same as that 

of ARC mode. For details, please see 6.1.3 Saving Point in ARC Mode 

 TRIGGER 

 OUTPUT 

 WAIT 

Name The name of the current saved point, which is user-defined 

Content The contents displayed depends on Type. You can double-click contents displayed in Content 

to modify them. 

 MOVL/MOVJ/JUMP/ARC/CIRCLE: Indicates the coordinate values, the velocity 

ratio and the jerk ratio of the movement when implementing playback. 

If Type of the current saved point is MOVL, ARC, or CIRCLE, Armorientaion must 

be the same as that of the previous saved point.  

 Trigger: Input of I/O interface 

 Output: Output of I/O interface 

 Wait: The pause time after the previous saved point is executed 

 

 Select a saved point and right-click on the line to copy, delete or other operations, as 

shown in Figure 6.11. 
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Figure 6.11  Right-click options of the saved points list 

 

 When modify the coordinates displayed in Content of which Type is motion mode, you 

can input the coordinate values manually or operate the operation panel to modify them. 

 Select the saved point on the left pane of the Playback page, double-click 

contents displayed in Content. 

The Motion Command Setting page is displayed, as shown in Figure 6.12. 

 

Figure 6.12  Modify the current saved point 

 Click the coordinate buttons on the operation panel pane of the Motion 
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Command Setting page to jog the Dobot M1. The coordinate is displayed on 

the Operation Panel pane of M1Studio page. 

 Click Get Current Pose to obtain the coordinate of Dobot M1. 

 Click Confirm to save the modified point. 

 If modifying the speed of all saved points at the same time is necessary, you can drag 

DynRatio to modify, as shown in Figure 6.13 

 

Figure 6.13  Modify the peed of all saved points at the same time 

 

 If you do not click Apply DynRatio, the modified speed goes into effect temporarily. 

Vel and Jerk displayed on the Playback page will not be changed, and the modified 

speed will not be saved if you click save. 

 If you click Apply DynRatio, Vel and Jerk displayed on the Playback page will be 

changed, and the modified speed will be saved to Playback files if you click save. 

 Scripting 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

Application Scenario 

You can control a Dobot M1 over scripting. Dobot M1 supports various API, such as 

velocity/acceleration setting, motion mode setting, and I/O configuration, which uses Python 

language for secondary development. For details about the Dobot M1 API interface and function 

description, please see Dobot API Interface Document. 

The download path is www.dobot.cc/downloadcenter/dobot-m1.html#most-download. 

Procedure 

 

https://www.dobot.cc/downloadcenter/dobot-m1.html?sub_cat=143#sub-download
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The Script page is displayed. 

 

You can double-click the interface to be used, the corresponding interface will be 

displayed on the script file page, as shown in Figure 6.14. You can also click  

icon of the corresponding interface on the left pane of the Script page to view the 

way how to set the parameters. The scripting example can refer to Installation 

directory/M1Studio/config/ststore/Example.script. 

NOTICE 

If you use the motion command when writing a program in Cartesian coordinate system, 

please add the orientation command before this motion command, which indicates the 

arm orientation of Dobot M1. 

 

  

Figure 6.14 Write a script 

 

 

The Save Scrip File page is displayed. 

 

 

The running log will be displayed on the lower pane of the Script page for checking.  

 Operating Blockly 

Prerequisites 

 The Dobot M1 has been powered on. 
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 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

Application Scenario 

Blockly is a programming platform based on Google Blockly. You can program through the 

puzzle format, which is straightforward and easy to understand.  

Procedure 

 

The Blockly page is displayed. 

 

 

Figure 6.15  Blockly graphics programming 

 

NOTICE 

If you use the motion command when writing a program in Cartesian coordinate system, 

please add the orientation command before this motion command, which indicates the 

arm orientation of Dobot M1. 
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Table 6.6  Description of blockly module 

No. Description 

1 The selection area of blockly module, including logistic, loop, math, and 

Dobot API. You can program by dragging them to the window. 

2 The window of blockly programming 

3 The running log of Dobot M1 

4 The corresponding codes of the blockly module on the programming 

window 

 

 

The Save Blockly File page is displayed. 

 

 

 Operating Laser Engraving 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The laser kit has been installed. For details, please see 3.3.1 Installing Laser Engraving 

Kit. 

 The picture to be engraved and materials to be processed have been prepared. 

 The lasing protective eyeglass has been prepared. 

Procedure 

 

The Laser Engraving page is displayed, as shown in Figure 6.16. 
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Figure 6.16  Laser Engraving GUI 

 

 

The picture (such as BMP, JPEG, JPG, PNG, and so on) is supported.  

 

Figure 6.17  Import picture 

 

NOTICE 

 The imported picture should be placed in the annular region, as shown in Figure 
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6.17. If not, it is unable to engrave normally and the border of the imported picture 

will be highlighted in red. 

 The annular region depends on the arm orientation. Please adjust the imported 

picture according to the real annular region. Figure 6.17 shows the annular region 

when arm orientation is left. 

 

 

The Laser Setting page is displayed. 

Please set the laser engraving parameters based on site requirements. 

Table 6.7  Laser engraving parameters 

Parameter Description 

CP Vel/ CP Acc Set the rate of CP velocity and acceleration 

PTP Vel/ PTP Jerk Set the rate of PTP velocity and jerk 

Grayscale Range Set the grayscale range 

Value range: 0-255 

Laser Power Range Set the laser power range 

Value range: 2-100 

Laser Height Set the laser height 

Border Width Set the border width of the picture 

Value range: 0-50 

XBias Set XBias 

DPI Set DPI 

 

 

Please wear the lasing protective eyeglass before adjusting the focus. 

Click the  icon of Motor on the Operation Panel pane of the M1Studio 

page and move the Dobot M1 by hand to a proper height, to make the laser dot 

appeared on the material burn the brightest. When the laser power is enough, you can 

view burning marks on the material. 

NOTICE 

 Please wear the lasing protective eyeglass before adjusting the focal length. 

 If the focal length still cannot focus, you can rotate clockwise the focal length of the 

laser head to adjust, as shown in Figure 6.18. 

 



                     Dobot M1 User Guide 6 Operation 

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

84 

 

Figure 6.18  Adjust focus 

DANGER 

 The laser can heat objects when it is in a focused state, so objects like paper or wood 

can be burned. 

 Do not focus the laser on people or animals. 

 Do not let children play with it alone. The process needs to be monitored when it is 

running. After the process is completed, please turn off the laser promptly. 

 

 

 

After performing this step, you will not need to adjust the focus manually when you 

engrave next time. You can click SyncPos directly after importing the picture. 

 

 

 Operating 3D Printing 

Prerequisites 

 The Dobot M1 has been powered on. 

 You have connected the Dobot M1 to a PC over a network cable, and the IP address of 

Dobot M1 and the PC must be in the same network segment. For details, please see 5.2.4 

Connecting Network Cable. 

 The Dobot M1 has been connected to an emergency stop switch. 

 The 3D printing kit has been installed. For details, please see 3.3.2 Installing 3D Printing 

Kit. 
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 Slice software Cura has been installed. The download path is 

https://ultimaker.com/en/products/cura-software/list. 

Please download the recommended version V15.04.6. The way on how to install and use 

is not described in this topic. 

 The 3D printing model and the firmware have been prepared. 

 The printing platform has been prepared and please place it in the workspace. 

NOTICE 

If the SN number of Dobot M1 is DT2118xxxxx and later numbers, please switch 3D 

printing mode directly to start 3D printing without an update. If you need to update the 

3D printing firmware, please see 6.9.2 Upgrading Firmware. 

xxx indicates the random number, please replace it based on site requirements. 

Procedure 

 

If Connect turns to Disconnect, the connection is successful. 

 

 

 Select Tools > Web Management on the M1Studio page. 

The Web management page is displayed. 

 Select Home in the navigation tree on the left. 

The Home page is displayed. 

 Select 3D printing Mode from the drop-down list on the Mode Switch 

Controlling pane of the Home page and click Switch, as shown in Figure 6.19. 

 

Figure 6.19  Switch 3D printing 

 

During switching, the green LED indicator will keep on. After completion, the 

green LED indicator will be blinking and Current Mode is changed to 3D 

Printing Mode, as shown in Figure 6.20. 
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Figure 6.20 Complete 3D printing switching 

 

 

 Unplug the network cable between the Dobot M1 and PC, and connect the 

Dobot M1 to the PC with the USB to DB9 adapter cable.  

 Select Machine > settings on the Cura page. 

The Machine settings page is displayed. 

 Set the corresponding parameters on the Machine settings and click OK, as 

shown in Figure 6.21. Table 6.8 lists the values of the parameters that need to 

be set. The other parameters are set by default. 

 

Figure 6.21 Parameters setting 
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Table 6.8  3D printing parameters description 

Parameter Description 

Maximum width The maximum width 

please set to 80mm 

Maximum depth The maximum with  

please set to 80mm 

Maximum height The maximum height 

Please set to 150mm 

Machine center 0,0 Machine center, please select it 

GCode Flavor The style of GCode 

Please select RepRap Marlin/Sprinter 

Build area shape Build the area shape 

Please select Circular 

Serial port Serial port 

Please select the corresponding serial port 

Baudrate Baud rate 

Please set to 115200 

 

NOTE 

The maximum width of 3D printing that Dobot M1 supports is 200mm, the maximum 

depth is 200mm, and the maximum height is 220mm. Please make the 3D-print in the 

Dobot M1 workspace. 

 

 Set slice parameters, and select File > Open Profile to import these parameters, 

as shown in Figure 6.22. 
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Figure 6.22  Import slice parameters 

The 3D printing effect depends on the slice parameters. This topic provides a 

configuration sample, you can import it directly for printing. 

The path of the configuration sample is Installation 

directory\M1Studio(Windows)Vxxx\DobotStudio\attachment, as shown in 

Figure 6.23. 

xxx indicates the version of M1Studio. Please replace it based on site 

requirements. 

 

Figure 6.23  Configuration sample 

 

Dobot-2.0-Vase.ini is used for printing a thin-walled vase, while Dobot-2.0-ini 

is used for the filling, the filling rate is 20%. 

 Click , the Open 3D model page is displayed, and select the 3D 

printing model prepared. 
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The format of 3D model is STL. You can design a 3D model and transform it 

into STL format. 

After importing the model, click the model itself, you can place it in the middle, 

zoom or rotate, and so on, as shown in Figure 6.24. 

 

Figure 6.24  Zoom and rotate 

 Click  to connect the Dobot M1. 

The printing window is displayed and the current printing temperature is shown 

on the top corner of the window, as shown in Figure 6.25. 

 

Figure 6.25  Printing window 

 

 Set Temperature to 200 and press down Enter to heat the extruder. 

The temperature of the extruder should be above 170℃. The Dobot M1 will not 

start 3D printing until the filament is in the melting state. So you need to heat 

the extruder first. 
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DANGER 

The heating rod will produce high temperature up to 250℃, please be careful. Do not let 

children play with it alone. The process needs to be monitored when it is running. After 

the process is completed, please turn off the equipment promptly. 

 

 

Before printing, you need to test the extruder to check whether the melted filament 

flows from the nozzle of the extruder.  

Click the feedstock extruder or click the given stepper, such as 10, 1, 0.1 (10 is 

recommended) on the Operational page and feed up to 10mm-30mm, as shown in 

Figure 6.26. 

 

Figure 6.26  Click feedstock extruder 

 

If the melted filament flows from the nozzle of the extruder, the extruder is working 

properly. 

 

 Click -Z or Click 10, 1, 0.1 to move the Dobot M1 to the position where the 

distance from the nozzle to the printing platform is about 0.3mm, as shown in 

Figure 6.27. 
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Figure 6.27  Move Z-axis 

 

NOTE 

During printing, if the distance from the Dobot M1 to the printing platform is too far or 

too close to paste the first layer, it can lead to the nozzle blockage. For increasing the 

stickiness of the first layer, placing a masking paper on the platform is recommended. 

 

 Input command M415 on the lower right of the Operational page to save the 

printing coordinates, as shown in Figure 6.28. 

 

Figure 6.28  Input command M415 

 

 

NOTICE 

If the yellow LED indicator is always on when printing a 3D module, the connection 

between the Dobot M1 and 3D printing kit is poor. Please check the connection and 
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restart the Dobot M1. 

 

 Operating I/O Assistant  

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to the PC successfully. 

 The Dobot M1 has been connected to the emergency stop switch. 

 The air pump has been installed (If you use an air pump to debug I/O interface). 

Application Scenario 

The end effectors such as gripper, suction cup need to work with the air pump. The air pump 

can be controlled by the I/O interface. You can verify the I/O interface and the air pump over I/O 

Assistant.  

Procedure 

If the air pump is connected to the base I/O interface, the outputs used are DOUT17, DOUT18 

respectively. For details, please see 3.4 (Optional) Installing Air Pump. The DOUT18 output 

controls the startup and shutoff of the air pump. 

 

The I/O Assistant page is displayed. 

 

 

Figure 6.29  I/O assistant 

 

The air pump is humming, which indicates that the air pump is enabled. The working 

state depends on the air pump. Please judge based on site requirements. 

 

The air pump is not humming, which indicates that the air pump is disabled. 

 Operating Collision Detection 
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Collision detection is mainly used for reducing the impact on the robot arm, to avoid damage 

to the robot arm or external equipment. If the collision detection is activated, the robot arm will stop 

running automatically when the robot arm hit an obstacle. 

NOTICE 

If you need to activate the collision detection, please make sure that the M1Studio version 

is V1.1.6 or later and the A9 firmware version is a9_app-0057 or later. If not, please 

download the right version from www.dobot.cc/downloadcenter/dobot-m1.html#most-

download. 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

Procedure 

 

 Remove the fixture on the robot arm and make sure that there are no obstacles 

within the workspace.  

If there is no fixture on the robot arm, please skip this step. 

 Select Tools > SafeSetting… on the M1Studio page. 

The Safe Mode Setting page is displayed. 

 Set Change Level to Low, PayLoad to 0, select EX Force Restart and click 

Save, as shown in Figure 6.30. 

 

Figure 6.30  Set collision detection parameters 

https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
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 Select Tools > DynamicSetting… on the M1Stuido page. 

The Dynamic Setting page is displayed. 

 Be sure to understand the precautions shown on the Dynamic Setting page and 

then click Start. 

After the process bar is 100%, the kinetic parameters will be obtained 

automatically, as shown in Figure 6.31. 

If the kinetic parameters you get is quite different from Figure 6.31, please re-

execute 1 - 5 since the obtained kinetic parameters are wrong. 

NOTICE 

 When obtaining the kinetic parameters, the robot arm will move in random 

directions for a while. Please make sure that there are no obstacles within the 

workspace, to avoid obtaining wrong kinetic parameters because of collision. 

 During robot arm running, please do not perform any other operation on the Dobot 

M1 or power off it, to avoid the Dobot M1 in an abnormal condition 

 When the unexpected occurs during robot arm running, please click Stop on the 

Dynamic Setting page. 

 

Figure 6.31  Obtain kinetic parameters 

 

 Click Save and Quit. 

The kinetic parameters are saved in the main controller. 

 

 

The Safe Mode Setting page is displayed. 

 

At this point, the parameters in the Set Params section will be generated 

automatically as the set sensitivity level, as shown in Figure 6.32. The details of these 

parameters are listed in Table 6.9. 

NOTICE 

The parameters in the Set Params section are only effective for horizontal collision 

detection. Please DO NOT modify these parameters. If the vertical collision detection is 
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required, please modify DiffJ3 to any value in the range from 40 to 50 and remain the 

rest unchanged. 

 

 

Figure 6.32  Set sensitivity level 

 

Table 6.9  Collision detection Parameters description 

Parameter Description 

Low No restrict. Namely, deactivate collision detection 

Middle Activate collision detection and the speed decreases 30%  

High Activate collision detection and the speed decreases 50% 
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Figure 6.33  Set payload 

 

 

Table 6.10  Post-collision measure description 

Parameter Description 

EX Force Restart Dobot M1 continues the current task by the external force (Horizontal) 

5s Restart Dobot M1 continues the current task automatically after 5 seconds 

 

 

 

 

When the Dobot M1 hit an obstacle during running, the Dobot M1 stops running 

automatically. If you touch the Dobot M1, it runs again, indicating that the setting is 

effective. 

Abnormal Handling 

After the collision detection is activated, if the collision detection is unexpected or the related 

alarm is triggered, please re-obtain the kinetic parameters.  

 Operating Web Management 

The web management of Dobot M1 integrates offline file management, firmware update, and 

application update, which is used to upload the offline files, make the Dobot M1 in the offline mode, 
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and update the applications. 

 Managing Offline File 

You can upload the scripts, the blockly programs, or the saved points lists that have been saved 

on a local PC to Dobot M1 using the web management, to perform offline operation. 

After making the Dobot M1 in the offline mode using the web management, the Dobot M1 will 

be disconnected from the M1Studio. You need to switch the operation mode of Dobot M1 using the 

web management. 

NOTICE 

If you need to operate a tray program in the offline mode, please make sure that the tray 

parameters are set on the network condition. Namely, when setting the tray parameters, 

you must use the network cable to connect the Dobot M1 and the PC. Otherwise, the tray 

information cannot be loaded into the Dobot M1 system. 

 

Prerequisites 

 You have launched M1Studio. 

 You have connected the Dobot M1 to a PC over a network cable, and the IP addresses of 

Dobot M1 and the PC must be in the same network segment. For details, please see 

5.2.4Connecting Network Cable. 

 You have powered on the Dobot M1. 

 You have saved the scripts, the blockly programs, or the saved points lists. 

 The Dobot M1 has been connected to an emergency stop switch. 

Application Scenario 

If the Dobot M1 needs to be running in the offline mode, please use the web management. 

Procedure 

 

 

The Web Management page is displayed. 

 

The Offline Script Management page is displayed. 

 

The Add File page is displayed. 

 

The uploaded file dialog box is displayed, as shown in Figure 6.34. 
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Figure 6.34  Upload files 

 

 

Only support the files, of which the suffixes are .playback, .blockly, and .script. 

 

 

Figure 6.35 Status of Uploading 
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Figure 6.36  Status of the uploaded files 

 

 

The Home page is displayed. 

 

 

Figure 6.37  Status of Dobot M1  

 

 Upgrading Firmware 

When the firmware or other applications need to be upgraded, you can use the web 

management to upgrade the firmware or the application. For example, if you want to use the 

collision detection or IP address forced configuration function, you can upgrade the Dobot M1 

firmware. 

DANGER 

When updating a firmware, please do not perform any other operation on the Dobot M1 

or power off it, to avoid Dobot M1 in an abnormal condition. Otherwise, it will be 

vulnerable to injury the device or the person. 
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Prerequisites 

 You have connected the Dobot M1 to a PC over network cable, and the IP addresses of 

Dobot M1 and the PC must be in the same network segment. For details, please see 5.2.4 

Connecting Network Cable. 

 You have powered on the Dobot M1. 

 You have obtained the latest A9 firmware a9_app-00xx.tar. xx indicates the firmware 

version, please replace it based on site requirements. 

The download path is https://www.dobot.cc/downloadcenter/dobot-m1.html#most-

download. 

 You have connected the Dobot M1 to an emergency stop switch. 

 You have obtained the latest M1Stuido. 

The download path is https://www.dobot.cc/downloadcenter/dobot-m1.html#most-

download. 

Procedure 

 

 

The Web Management page is displayed. 

 

The Update A9 Program page is displayed, as shown in Figure 6.38. 

 

Figure 6.38  A9 Program GUI 

 

 

NOTICE 

If the version of the obtained firmware is 0058 or later, please click Update again after 

Status is 100%, to avoid update failure. 

 

 

If the A9 firmware version changes to the updated version, it indicates that the update 

https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
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is successful. 

 

Figure 6.39  Update A9 firmware 

 

 

 

The Update Firmware page is displayed, as shown in Figure 6.40. 

 

Figure 6.40  Update Firmware GUI 
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Figure 6.41  Update order 

 

You can view the process of the firmware upgrade. If the progress bar is 100% and 

the green LED indicator on the base of Dobot M1 is blinking, the update is 

completed, as shown in Figure 6.42 and Figure 6.43. And then the next firmware 

update can be started. 

 

 

Figure 6.42  Process of the firmware upgrade 
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Figure 6.43  LED indicator status 

 

NOTICE 

 Please update the firmware exactly as the order shown in Figure 6.41 and the next 

firmware update should not be started until the current one is completed. Otherwise, 

the update will fail. 

 When updating a firmware, please do not perform any other operation on Dobot M1 

or power off it, to avoid Dobot M1 in an abnormal condition. Otherwise, it will be 

vulnerable to injury the device or the person. 

 

 

After the 3D printing firmware is updated, Dobot M1 will switch to 3D printing 

mode, you need to switch the Dobot M1 to Dobot mode. Otherwise, the Dobot M1 

cannot work normally. 
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Figure 6.44  Mode switch 

 Example 

 Example of the Trajectory 

This topic describes how to use the motion modes according to the real trajectory when the 

Dobot M1 is running. 

Figure 6.45 shows the real trajectory when the Dobot M1 is running. Figure 6.46 shows the 

coordinates of the trajectory. 

NOTICE 

This topic only describes the motion modes that need to be used and precautions for 

implementing playback, without details about the trajectory. For details on how to 

implement playback, please see 6.2 Operating Teaching and Playback. 
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Figure 6.45 Trajectory of Dobot M1 

 

 

Figure 6.46  Cartesian coordinate of the trajectory 

 

If point A is the starting point, and Point B is the end point. From Point A to Point J, the 

coordinates are listed as Table 6.11. 

Table 6.11 Cartesian coordinates 

Point Coordinate (x,y,z,r) 

A (270,-244,110,0) 

B (400,0,110,0) (Singular point) 

C (366,111,110,0) 

D (194,111,110,0) 

E (194,277,110,0) 

F (85,250,110,0) 

G (-44.4458,239.5284,110,33.08) (The middle point of the arc) 

H (-120.6913,164.5902,110,65.6601) 

I (372.225,-63.2786,110, -148.8402) 

K (351.7533,-113.7360,110, -160.2802) (The middle point of the 

circle) 

J (323.1731,-115.7006,110, -170.5002) 
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Figure 6.47 shows an example of the saved points list. 

 

Figure 6.47  Example of the saved points 

 

 From point A to point B (0->1): The trajectory is non-linear, and point B is a singular 

point. So MOVL or ARC mode cannot be used, but MOVJ mode is applicable. For details 

about singular point, please see 6.1.2 Alarms Description. 

 From point B to point C (1->2): The trajectory looks like a door. So JUMP mode is 

required. You need to set Height and Limit when saving point. The trajectory in JUMP mode 

depends on Height and Limit. For details, please see 2.3.4.2 Point to Point Mode (PTP). 

 From point C to point D (2->3): The trajectory is a straight line. So MOVL mode is 

required. The arm orientations of point D and point C must be the same. Otherwise, an alarm 

will be generated. 

 From point D to point E (3->4): The trajectory is a straight line. So MOVL mode is 

required. The arm orientations of point E and point D must be the same. 

 From point E to point F (4->5): The trajectory looks like a door. So JUMP mode is 

required. You need to set Height and Limit. 

 From point F to point H (5->6): The trajectory is an arc. So ARC mode is required. Besides 

point F and point G, you need to save point G. For details, please see 6.1.3 Saving Point in 

ARC Mode. The arm orientation of point F must be the same as that of point G and point H. 

 From point H to point I (6->7): The trajectory looks like a door. So JUMP mode is 

required. You need to set Height and Limit. 

 From point I to point J (7->8): The trajectory is a circle. So CIRCLE mode is required. 

Besides point I and point J, you need to save point K. The method to save point in CIRCLE 

mode is the same as that of ARC mode. The arm orientation of point I must be the same as that 

of point J and point K. 

 Example of I/O 

6.10.2.1 Example of Digital Output 

Figure 6.48 shows the connection between the I/O interface and control device. VCC_24V 

is positive electrode of power supply on the Dobot M1 I/O interface or external power supply. 

DOUTx is the output of the I/O interface. Please select the proper outputs based on site 

requirements. For details, please see 4.3 Interface Description. 



                     Dobot M1 User Guide 6 Operation 

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

107 

 

Figure 6.48  Connection between I/O interface and control device by default 

 

NOTICE 

Please DO NOT connect digital output to power interface without load limiting. 

 

6.10.2.2 Example of External Expansion I/O Control 

External I/O control means that external equipment controls a robot arm by the external 

expansion I/O. In this topic, we take a PLC as the external equipment to describe how to use a PLC 

to control the robot arm by the external expansion I/O. Besides the robot arm and PLC, we need to 

prepare a DB62 expansion suite (include DB62 cables and expansion board, and purchase 

separately). Figure 6.49 shows the DB62 expansion suite. 

 

Figure 6.49  DB62 expansion board 

 

For details about the external expansion I/O interface description, please see 4.3.3 External 

Expansion Interface. 

Prerequisites 

 You have launched M1Studio.  

 You have connected Dobot M1 to a PC over network cable or router, and the IP addresses 

of Dobot M1 and the PC must be in the same network segment. For details, please see 

5.2.4Connecting Network Cable. 
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In this topic, we use a router to connect the Dobot M1 to a PC. 

 You have powered on the Dobot M1. 

 You have obtained the scripts, the blockly programs, or the saved points lists which are 

run normally. In this topic, we take a script as an example. 

 Dobot M1 has been connected to an emergency stop switch. 

 You have installed the PLC programming software. 

In this topic, we use the FX5U PLC and GX Works3 programming software. For details 

on how to use are not described in this topic. 

Figure 6.50 shows the connections demo. 

 

Figure 6.50  Connection Demo 

 

Procedure 
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Figure 6.51  Connect to external expansion I/O interface 

 

 

 

Please use the wires of which the size is from 20 AWG to 24 AWG for connections. 

  

Figure 6.52  Connection between PLC and expansion board 

 

Table 6.12 lists the definitions of external expansion I/O interfaces from DIN10 to DIN15. 
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Table 6.12  DIN10 - DIN 15 interfaces definition 

Interface Description 

DIN10 Reset signal 

DIN11 External I/O control signal. Namely, the Dobot M1 activates the external I/O control 

function 

DIN12 Continue signal 

DIN13 Pause signal 

DIN14 Stop signal 

After this signal is triggered, the Dobot M1 will stop offline running while the external 

I/O control will remain in force. At this point, you can use the M1Studio to control the 

Dobot M1 in the Dobot mode or trigger DIN 15 to make the Dobot M1 run in the offline 

mode again 

DIN15 Start signal, for running in the offline mode 

Before triggering this signal, please trigger DIN 11 

 

 

NOTE 

All digital input signals are falling edge triggered.  

 

 

 Select the corresponding IP address from the serial drop-down list on the upper 

left pane of the M1Studio page and click Connect. 

 Click Tools > Web Management > Upload Offline Script to upload the script 

to the main controller, as shown in Figure 6.53. 

 

Figure 6.53  Upload script 
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 Select the uploaded script on the Offline Script Management page and click 

Offline to make the script in the offline status, as shown in Figure 6.54. 

  

Figure 6.54  Script status 

 

 

How to build a PLC project is not described in this topic. 

 

Figure 6.55  PLC program 

 

 Select the corresponding IP address from the serial drop-down list on the upper 

left pane of the M1Studio page and click Connect. 

 Select Tools > I/O Assistant. 

The I/O Assistant page is displayed. 

 Trigger Y0 on the GX Works3 page, and observe the changes of DIN 10 on the 

I/O Assistant page. 

If the voltage of DIN 10 shown on the I/O Assistant page is changed, it 

indicates that the connection is correct. Otherwise, please reconnect it. 

 Check DIN 11 - DIN 15 according to 3 and Figure 6.52. 

It is recommended that DIN 11 is checked at last, since DIN 11 is triggered, the 
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Dobot M1 activates the external I/O control function, and then when DIN 15 is 

triggered, Dobot M1 will run in the offline mode. 

 

 Trigger Y1 on the GX Works3 page, the Dobot M1 will activate the external I/O 

control function. 

 Trigger Y5 and the Dobot M1 will run in the offline mode. 

If stopping the Dobot M1 running in the offline mode is required, please trigger Y4. At this 

point, the Dobot M1 stops offline running, while the external I/O control remains in force. If 

continuing the Dobot M1 running in the offline mode is required, please trigger Y5 directly. 

6.10.2.3 Example of Relay Connection 

DOUT9 and DOUT10 are used to control the relay K1 and K2 respectively, which are internal 

encapsulated interfaces. If you have to use a relay, you can use the COM, NC, NO interfaces directly 

on the external expansion board after the external expansion board connects to the Dobot M1. If you 

have to test the relay K1 and K2, you can debug OUT09 and OUT10 on the M1Studio > I/O 

Assistant page. 

This topic takes a magnetic valve as an example to describe how to connect to a relay. 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 The Dobot M1 has been connected to an emergency stop switch. 

 The Dobot M1 has been connected to a DB62 external expansion board. 

Procedure 

 

Take the relay K2 as an example. 

 Set the multimeter to Continuity mode and connect one probe to COM2 

interface, and connect the other probe to NC2 interface. 



                     Dobot M1 User Guide 6 Operation 

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

113 

 

Figure 6.56  Using multimeter to test relay 

 

 Click 24V of OUT10 on the Output pane of the I/O Assistant page. 

If a tone is emitted, the Normally-Closed function works normally. 

 Connect one probe to COM2 interface, and connect the other probe to NO2 

interface. 

 Click 0V of OUT10 on the Output pane of the I/O Assistant page. 

If a tone is emitted, the Normally-Open function works normally. 

 

When the status of EX_OUT10 is high level, the magnetic valve will not work. 

While the status of EX_OUT10 is low level, the magnetic valve will work. 
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Figure 6.57  Connect to magnetic valve 

 

 Example of Switching the Arm Orientation at the Same Point 

In MOVJ or JUMP mode, if the two points are the same, only different in arm orientations, J1 

or J4 may be limited when the Dobot M1 is moving, resulting in an alarm generated. You need to 

modify and resave the point for which the alarm is generated, and then clear the alarm manually. 

The R-coordinate is the sum of the coordinates of J1, J2, and J4. The terminal posture relative 

to the origin stays constant when moving the Dobot M1. Table 6.13 lists how to calculate each Joint 

coordinate after switching the arm orientation at the same point. 
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Table 6.13  Joint coordinate calculation 

Before After 

R=J1+J2+J4 R’=R=J1’+J2’+J4’ 

J1 J1’=J1+J2 

J2 J2’=-J2 

J3 J3’=J3 

J4 J4’=R-J1’-J2’ 

 

As shown in Table 6.13, If the J1-coordinate is 10° and the J2-coordinate is 90° before 

switching the arm orientation, the J1-coordinate will change to 100° after switching, resulting in a 

limitation alarm. In the real application scenario, if the two successive saved points are the same, 

only different in arm orientations, please notice the coordinates of J1 and J4. You can calculate the 

coordinates of J1 and J4 according to Table 6.13, in order to avoid generating a limitation alarm. 

 Example of TCP/IP Control 

TCP/IP control means that external equipment controls a robot arm by sending commands with 

TCP/IP. External equipment is the client, and main controller or M1Studio is the server, as shown 

in Figure 6.58. Moreover, the IP address of the client and server must be in the same network 

segment. 

 

Figure 6.58  Communication process 

 

This topic describes how to use the external equipment to control the robot arm by sending 

commands with TCP/IP. 

Prerequisites 

 The Dobot M1 has been connected to a PC successfully. For details, please see 5.2.3 

Connecting Serial Port or 5.2.4Connecting Network Cable. 

If the server is the main controller, you must connect the Dobot M1 to a PC with a network 

cable. 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to the emergency stop switch. 

Procedure 
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To build a remote control system, we need to create a server. We can take the PC 

where the M1Studio is located or the main controller as a server. Program 6.1 shows 

the server script demo (supposing that the name is syncServer.script), and the parts 

of the demo shown in bold can be user-defined. 

 If the server is the PC where the M1Studio is located (Supposing that IP address is 

192.168.1.10), the Dobot M1 can be connected to the PC by a serial port or a network 

cable, and HOST, PORT = "192.168.1.10", 50030. 

The port cannot be occupied. 

 If the server is the main controller (Suppose that IP address is 192.168.1.20), the 

Dobot M1 can only be connected to PC by a network cable, and HOST, PORT = 

"192.168.1.20", 50030. 

The port cannot be occupied. 

NOTICE 

The IP address of server and client must be in the same network segment. Otherwise, the 

remote control is invalid. 

 

Program 6.1  Sever script 

import socket 

import threading 

import socketserver 

import time 

import math 

 

class ThreadedTCPRequestHandler(socketserver.BaseRequestHandler): 

def setup(self): 

ip = self.client_address[0].strip()  

port = self.client_address[1]  

print(ip+":"+str(port)+" is connect!") 

 

def handle(self): 

while True: # add while for keep link 

data = self.request.recv(1024) 

if data: 

data = str(data, encoding = 'ascii') 

if data == 'exit': 

break; 

OperCMD(data) 
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#cur_thread = threading.current_thread() 

 

#print what recieved 

response = bytes("{}".format(data), 'ascii') 

self.request.sendall(response) 

 

def finish(self):  

print("client is disconnect!") 

print("stop") 

server.shutdown() 

exit(0) 

class ThreadedTCPServer(socketserver.ThreadingMixIn, socketserver.TCPServer): 

pass 

 

def OperCMD(strCMD): 

print(strCMD) 

 

#decode command type 

commandtype = strCMD[ : 3] 

print(commandtype) 

 

#get the value of command 

#    index = strCMD.find(',') 

#    tempStr1 = str[index+1 : ] 

 

#get X coord 

#    index = tempStr1.find(',') 

#    tempStr2 = tempStr1[:index] 

#    PosX = tempStr2 

#    print(PosX) 

#    tempStr1 = tempStr2 

 

#get Y coord 

 

if (strCMD == "exit"): 

print("stop") 

server.shutdown() 
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exit(0) 

elif (strCMD == "MoveP1" or strCMD == "p1"):      // Send Move P1 or P1 command, Dobot M1 

 will move as the following commands 

dType.SetArmOrientation(api, 1, 1) 

dType.SetPTPCmd(api, 0, 229, 212, 120, 0, 1) 

dType.SetARCCmd(api, [62,265,120,50], [-58,266,120,76], 1) 

elif (strCMD == "MoveP2" or strCMD == "p2"):       //Send Move P2 or P2 command, Dobot M1  

will move as the following commands 

dType.SetArmOrientation(api, 1, 1) 

dType.SetPTPCmd(api, 0, 229, 212, 120, 0, 1) 

dType.SetARCCmd(api, [62,265,120,50], [-58,266,120,76], 1) 

 

HOST, PORT = "192.168.1.10", 50030                 // IP address and Port of the server 

socketserver.TCPServer.allow_reuse_address = True 

server = ThreadedTCPServer((HOST, PORT), ThreadedTCPRequestHandler) 

ip, port = server.server_address 

server_thread = threading.Thread(target=server.serve_forever) 

server_thread.daemon = True 

server_thread.start() 

server.serve_forever() 

 

 

NOTE 

The way to import the script depends on the server, please select based on site 

requirements. 

 

 If the server is the PC where the M1Studio is located, please execute the following 

steps. 

 Select the corresponding serial port or IP address from the serial drop-down list 

on the upper left pane of the M1Studio page and click Connect. 

 Import the script on the Script of M1Studio page and click Start. 

 If the server is the main controller, please execute the following steps. 

 Select the corresponding IP address from the serial drop-down list on the upper 

left pane of the M1Studio page and click Connect. 

 Click Tools > Web Management > Upload Offline Script to upload the script 

to the main controller, as shown in Figure 6.59. 
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Figure 6.59  Upload script 

 

 Select the uploaded script (syncServer.script) on the Offline Script 

Management page and click Offline to make the script in the offline status, as 

shown in Figure 6.60. 

 

Figure 6.60  Script status 

 Select Offline Mode from the drop-down list on the Mode Switch Controlling 

pane of the Home page, and click Start to make Dobot M1 in the Offline Mode 

status, as shown in Figure 6.61. 

Now, the blue LED indicator on the base of Dobot M1 is blinking. 

 

Figure 6.61  Mode switch 
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Input the IP address and port of the server on the client and click Connect, as shown 

in Figure 6.62. 

NOTE 

The external equipment used for controlling a robot arm depends on the actual 

applications. In this topic, we take debugging assistant as an example to describe how to 

configure client, please replace it based on site requirements. 

 

 

Figure 6.62  Configure client 

 

 

Now, the Dobot M1 will move as the motion commands in the script. 
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Figure 6.63  Send commands on the client 

 

 Example of Tray 

NOTICE 

If you need to activate the collision detection, please make sure that the M1Studio version 

is V1.4.0 or later and the A9 firmware version is a9_app-0062 or later. If not, please 

download the right version from www.dobot.cc/downloadcenter/dobot-m1.html#most-

download. 

 

In carrying applications, some parts are regularly arranged with uniform spacing and teaching 

part positions one by one results in a high error and poor efficiency. Tray function can resolve these 

problems. 

A full tray process includes tray parameters setting and tray programming. After you set the 

tray parameters on M1Studio, the generated configuration file will be imported to the robot system 

automatically, then you can write a tray program by calling tray API based on site requirements. 

Tray parameter settings include basic parameter setting and path point setting. Basic parameter 

setting is to set tray plane, high, tray name, and tray direction. Path points are the configured points 

on the assembly path or dismantling path. 

 Three points, P1, P2, and P3, confirm the plane of the tray. P1 is also the first target point 

for. 

 Transition point (point A): A point the robot must move to when assembling or 

dismantling stacks, which is fixed or varies with the tray layer. 

https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
https://www.dobot.cc/downloadcenter/dobot-m1.html#most-download
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 Preparation point (point B): A point calculated by the target point and the set offset. 

 Figure 6.64 and Figure 6.65 show the assembly path and dismantling path. 

 

Figure 6.64  Assembly path 

 

 

Figure 6.65  Dismantling path 

 

In our robot system, only the matrix tray is supported, on which the stacks are placed in regular 

intervals, as shown in Figure 6.66. 
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Figure 6.66  Matrix tray 

 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to a PC successfully. 

 An End-effector has been installed based on site requirements. 

Procedure 

 

The Script page is displayed. 

 

The Matrix Tray page is displayed, as shown in Figure 6.67. 

 

Figure 6.67  Matrix Tray page 

 

Table 6.14 lists the tray parameters description. 
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Table 6.14  Tray parameter description 

Parameter Description 

Ready Point Preparation point 

Transition Point Transition point 

P1 Determine the point 1 on the pallet plane, and also place the point 

for the target of the first object 

P2 Determine the point 2 on the pallet plane 

P3 Determine the point 3 on the pallet plane 

Z Lifting height of the end of the robot arm, this point needs to be 

set higher than the object, and the end of the robot collides with 

the object 

R Teach the end angle of the robot arm to make the angle meet the 

requirements of the on-site tray. Click Teach to get the angle of 

R 

Count Number of objects in directions P1 to P3 

Column Number of objects in directions P1 to P2 

Name Tray name 

 

 

NOTICE 

If you need to operate a tray program in the offline mode, please make sure that the tray 

parameters are set on the network condition. Namely, when setting the tray parameters, 

you must use the network cable to connect Dobot M1 and PC. Otherwise, the tray 

information cannot be loaded into the Dobot M1 system. 

 

 Jog the robot to the preparation point and click Teach on the Ready Point 

section to obtain the preparation point value. 

 Jog the robot to the transition point and click Teach on the Transition Point 

section to obtain the transition point value. 

 Teach the robot to a point on the plane, and click Teach on the P1 line to obtain 

the P1 coordinate position. 

 Teach the robot to a point on the plane, and click Teach on the P2 line to obtain 

the P2 coordinate position. 

 Teach the robot to a point on the plane, and click Teach on the P3 line to obtain 

the P3 coordinate position. 

 Teach the robotic to a certain height (the height needs to exceed the tray), click 
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Teach to obtain the lifting height Z. 

 Teach the end angle of the robot arm so that the angle complies with the 

requirements of the field tray. Click "Teach" to get the angle of R. 

 Set Count and column. 

 Set the tray name. 

 

The tray list will be displayed on the Script page, as shown in Figure 6.68. 

 

Figure 6.68  Tray list 

 

You can right-click the right tray to modify or delete the tray configuration 

information. 

 

NOTICE 

Please make sure that the tray name in the matrixPallet.setMatrixPallet(Tray name) is 

same as that on the Matrix tray list. 

 

Program 6.2  Assembly tray Demo 

dType.SetArmOrientation(api, 0, 1) 

dType.SetPTPCommonParams(api, 100, 10, 1) 

#palle1 is a tray name 

matrixPallet.setMatrixPallet("pallet1") 

#Get ready point  

readyPoint = matrixPallet.getReadyPoint() 

print("readyPoint:", readyPoint[0], readyPoint[1], readyPoint[2], readyPoint[3]) 

#Get transition point 

transPoint = matrixPallet.getTransPoint() 

print("transPoint:", transPoint[0], transPoint[1], transPoint[2], transPoint[3]) 
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#Get tray points 

palletPoint = matrixPallet.getPalletPoint() 

 

for point in palletPoint: 

# Traversal tray points 

dType.SetPTPCmd(api, 1, readyPoint[0], readyPoint[1], readyPoint[2], readyPoint[3], 1) 

dType.SetPTPCmd(api, 1, transPoint[0], transPoint[1], transPoint[2], transPoint[3], 1) 

print("point:", point[0], point[1], point[2], point[3]) 

dType.SetPTPCmdEx(api, 1, point[0], point[1], point[2], point[3], isQueued=1) 

 

 Example of Safeguard Stop 

The safeguard stop function is used to suspend robot movement in a safe mode. Namely, when 

the safeguard stop function is enabled and the safeguard input signals are triggered, the robot stops 

immediately and enters into pause state. In Dobot M1 system, the DI7, DI8 and DI9 interfaces on 

the DB62 expansion board are safeguard inputs, which can connect to safety doors, light curtains, 

safety floor mats, etc. 

NOTICE 

 The safeguard input interfaces are available only when the safeguard stop function 

is enabled. If not enabled, the DI7, DI8 and DI9 on the DB62 expansion board will 

be used as the common digital input interfaces. 

 In normal use of Dobot M1, please DO NOT enable safeguard stop function at will. 

Otherwise, the scripts cannot be run. 

6.10.6.1 Immediate recovery mode 

The immediate recovery mode is only DI7 and DI8 as safety interfaces. The robot stops moving 

after disconnecting DI7 and DI8, and the robot arm resumes motion after receiving DI7 and DI8. 

Prerequisites 

 The Dobot M1 has been connected to an emergency stop switch. 

 The Dobot M1 has been connected to the DB62 expansion board. 

Procedure 
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Figure 6.69  Connect DB62 expansion board to the door switch 

 

When the safeguard stop function is enabled, either or both of DI7 and DI8 interfaces are 

disconnected from PGND interface, the safeguard stop will be triggered and Dobot M1 will stop 

moving without clearing the queue in the Dobot M1 system. Only when both DI7 and DI8 interfaces 

are connected to PGND interface, the Dobot M1 will move again. 
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Figure 6.70  Enable safeguard stop function 

 

If  turns into , it indicates that the safeguard stop function is 

enabled. 

 

6.10.6.2 I/O trigger recovery mode 

The I/O trigger recovery mode is DI7, DI8, and DI9 as safety interfaces. The robot stops 

moving after disconnecting DI7 and DI8, and the robot does not resume motion after returning DI7 

and DI8. It can be triggered only when DI9 is connected to a low level. The robotic resumes 

movement. 

Prerequisites 

 The Dobot M1 has been connected to an emergency stop switch. 
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 The Dobot M1 has been connected to the DB62 expansion board. 

Procedure 

 

 

Figure 6.71  Connect DB62 expansion board to the door switch and a normally open switch 

 

When the safeguard stop function is enabled, either or both of DI7 and DI8 interfaces are 

disconnected from PGND interface, the safeguard stop will be triggered and Dobot M1 will stop 

moving without clearing the queue in the Dobot M1 system. Only when both DI7 and DI8 interfaces 

are connected to PGND interface, and DI9 connected to low level, the Dobot M1 will move again. 
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Figure 6.72  Enable safeguard stop function 

 

If  turns into , it indicates that the safeguard stop function is 

enabled. 
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 Maintenance 

 Routine Maintenance 

 Routine Inspection 

Due to the temperature, humidity, dust, and vibration, the components will be aged, leading to 

reducing product service life. Performing maintenance inspections and procedures properly is 

essential for preventing trouble and ensuring safety. Especially in high-temperature environment, 

frequently start-stop scenario, and other special scenarios, you need to shorten the inspection period. 

To ensure product function and safety, please check the following items daily. 

Item Operating state Inspection point Solution 

External cable OFF  Check whether the 

cables are damaged 

or cracked 

 check whether the 

cables are loose, 

dirty or polled out  

 If the cables are 

damaged or 

cracked, please 

repair or replace 

them timely 

 If the cables are 

loose or polled out, 

please plug them 

properly 

 If the cables are 

dirty, please clean 

them timely 

Bolt, screw OFF  Check whether the 

bolts on the end of 

the robot arm are 

loose 

 Check whether the 

bolts on the base are 

loose 

If the bolts are loose, 

please tighten them 

Cover OFF Please check  the covers 

of robotic arm are flawed 

If that happens, please 

replace them timely 

Startup ON Check whether the robotic 

arm is shaken 

 If the connections 

are abnormal, 

please reconnect 

them  

 If the screws are 

loose, please tighten 

them 
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Emergency stop switch, 

LED indicators and 

buttons 

ON Check whether the LED 

indicators are displayed 

normally and the  

emergency stop switch is 

working regularly 

If that happens, please 

replace the corresponding 

components timely 

 

 Periodic Inspection 

In order to keep the good operation of the robotic arm, please check the place where it is hard 

to check regularly. The inspection period depends on the operating environment and frequency, 

please decide the inspection period based on site requirements. Please remove surface dust 

effectively to prevent dust (especially metal dust) from entering the product, ensuring that the 

robotic arm is always clean. 

Item Operating state Inspection point Inspection period Solution 

Internal fan of a 

robotic arm 

ON  Check 

whether the 

fan is running 

properly 

 Check 

whether the 

fan is dusty 

3 months  If the fan is 

out of service, 

please replace 

it 

 If the fan is 

dirty, please 

use 

compressed 

air to clean 

the surface 

dust 

Mechanical 

limitation of J1, J2, 

J3 

OFF Check whether the 

joints are cracked 

6 months If that happens, 

please replace it 

timely 

Synchronizing 

wheel of R-axis 

OFF Check whether the 

synchronizing 

wheel is loose 

6 months If that happens, 

please re-tension it 

Bolt, screw OFF  Check 

whether  the 

screws and 

bolts around 

each joint of 

the robotic 

arm are loose 

 Check 

whether the 

screws and 

12 months If that happens, 

please tighten them 



                     Dobot M1 User Guide 7 Maintenance 

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

133 

bolts of motor 

and reducer 

are loose 

Enabling the 

robotic arm 

ON Check whether each 

arm can be moved 

by hand in the 

disabled state 

12 months If that happens, 

please contact the 

technical support 

engineer 

 

 Cleaning Maintenance 

The cleaning period depends on the operating environment and frequency, please decide the 

cleaning period based on site requirements. 

Item Operating state Cleaning period Solution 

Robotic arm OFF 1 month Please clean the surface 

with a clean cloth 

Wind tunnel OFF 2 weeks Please clean the 

impurities stored in the 

wind tunnel with an air 

gun or a clean cloth 

Screw rod of Z-axis OFF 12 months Please add the lubricating 

oil or grease. For details, 

please see 7.2.1 Greasing 

Screw Rod of Z-axis 

Guide rail of Z-axis OFF 6 months or running 100 

km 

Please add the lubricating 

oil or grease. For details, 

please see 7.2.2 Greasing 

Guide Rail of Z-axis 

 

Common disinfectant, cleaning liquid can be used for cleaning the robotic arm. Please do not 

use the acidic cleaning fluid for routine maintenance. 

 Maintenance of Mechanical Parts  

 Greasing Screw Rod of Z-axis 

If the grease on the screw rod has been used up, the screw rod may be worn down and make a 

noise. You need to check the grease every other year. If the grease is applied too much or uneven, 

the load of the motor may be increased and the grease may be dripped from the screw rod. You can 

check whether the grease is used up by wiping the surface of the screw rod with air-laid paper. If 

there is no grease on the air-laid paper, the grease is used up. 

Procedure 
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If Connect turns to Disconnect, the connection is successful, and the Dobot M1 can 

be controlled by the M1Studio. 

 

 

 

 

Figure 7.1  Screw rod of Z-axis 
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It can be put into use after installation. 

 Greasing Guide Rail of Z-axis 

If the guide rail is used without grease, the guide rail will be worn down and the service life 

will be reduced. You need to grease the guide rail every two weeks for long service. 

Prerequisites 

Please prepare the correct-size syringe (a diameter of no more than 2cm) and needle to ensure 

that the syringe can touch the guide rail of Z-axis. 

Procedure 

 

 

After 15 minutes, restart the Dobot M1 to put it into use. 

 

Figure 7.2  Guide rail of Z-axis 

 

 Maintenance of Electrical Parts  

NOTICE 
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Please notice the anti-static precautions during the electrical operation, such as wearing 

an anti-static wrist strap to ensure that the internal parts of the robotic arm are not 

damaged. 

 

 Encoder Battery Maintenance 

When the battery voltage is less than 3V, the homing point may be incorrect, and the alarm 

about low battery voltage is generated, as shown in Figure 7.3.  

 

Figure 7.3  Low battery voltage alarm 

 

There are two ways to maintain Encoder battery. 

 Temporary use: Execute the homing procedure to reset the Encoder automatically and 

recover the homing point. For details, please see 7.3.1.1Operating Homing Procedure. 

 Enter Battery-Change Guide: Replace battery. For details, please see 7.3.1.2 Replacing 

Encoder Battery. 

7.3.1.1 Operating Homing Procedure 

NOTICE 

 Only the Dobot M1 of which the SN number is DT2118xxxxx and later numbers 

has installed the homing switch. If not, this procedure is not supported. 

xxx indicates the random number, please replace it based on site requirements. 

 Please make sure that the A9 firmware version is 02005800 or later, that the Dobot 
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firmware version is 1.3.0 or later, that the driver firmware version is 1.3.2 or later 

before executing the homing procedure. Otherwise, a limitation alarm will be 

triggered when executing the homing procedure, resulting in homing failure. The 

Dobot M1 firmware versions can be viewed on the M1Studio > Help > About 

M1Studio page. If the related versions are too low, please upgrade them. For details, 

please see 6.9.2 Upgrading Firmware. 

 

Procedure 

DANGER 

Please DO NOT click Initialization.exe when executing the homing procedure. 

Otherwise, the Dobot M1 may move following an unexpected path, resulting in 

interference with peripheral equipment. 

 

 

The No Battery Mode page is displayed, as shown in Figure 7.4. 

 

Figure 7.4  No battery mode page 

 

 

The Dobot M1 starts homing, as shown in Figure 7.5. 
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Figure 7.5  Start homing 

 

NOTICE 

Please DO NOT click  during the homing procedure, to avoid homing procedure 

failure. 

 

 

 J3 moves to the upper limit with a signal triggered by the homing switch, and 

moves backward at low speed to separate from the homing switch, and then stops 

moving. 

 J1 and J2 move to the limit as lefty hand orientation with signals triggered by 

homing switches of J1 and J2, and move backward at low speed to separate from 

the homing switches, and then stop moving, indicating that the Dobot M1 has 

moved to the homing point. 

 

After the homing procedure is completed, the coordinate of the homing point is 

shown in Figure 7.6. 
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Figure 7.6  Homing point 

 

Troubleshooting 

When the homing process fails, there may be the following reasons. 

 If an over-current alarm of a joint is generated, it indicates that the homing switch is not 

available. You need to adjust the homing switch manually. For details, please contact 

Dobot support engineer.  

 If the coordinates you get is quite different from Figure 7.6, it indicates that the homing 

procedure fails, please click Initialization.exe in the Installation 

directory/DobotStudio/tools/Initialization directory to reset homing position. For details, 

please contact Dobot support engineer. 

 If only the Z-axis coordinate is wrong, please execute the following steps. 

 Make the Dobot M1 in the disabled state and jog the Dobot M1 by hand to make 

it to the bottom of Z-axis, as shown in Figure 7.7. 
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Figure 7.7  Location of Dobot M1 after Factory calibration 

 

 Click Initialization.exe in the installing directory/M1Studio/tools/Initialization 

directory.  

 Click the  icon of Motor on the Calibration page to make the 

motor of Dobot M1 in the enabled state.  

 Click InitPos on the Debug page as shown in Figure 7.8, to make the Dobot 

M1 in the origin position of which the coordinate is (400,0,0,0). 
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Figure 7.8  Initial the homing position 

 

7.3.1.2 Replacing Encoder Battery Procedure 

 

The battery change guide page is displayed, as shown in Figure 7.9. 
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Figure 7.9  Battery change guide page 

 

Now, you can replace the battery as the process shown in Figure 7.9. 

 

Table 7.1  Replacement parts list 

Type Name Quality Remark 

Maintenance parts Battery with welding 

cable LS 14250 

1 - 

Zip-tie 2 Please prepare by 

yourself 

Tools Hexagonal wrench 

(2.5mm) 

1 - 

Cross head screw-

driver 

1 Please prepare by 

yourself 

Nippers 1 Please prepare by 

yourself 
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NOTICE 

After replacing the battery, please do not dispose of elsewhere. All discarded batteries 

must be uniformly reclaimed to avoid environmental contamination. 

 

 Remove the original battery. For details, please see 7.3.1.3 Remove Original 

Battery. 

The battery is located on the main controller of the base or on the Forearm. The 

position of the battery depends on the production batch of Dobot M1. 

 

 Remove the Forearm cover with 2.5mm hexagon wrench and cross head screw-

driver. If it has been removed, please skip this step. 

 Unplug the CAN cable, as shown in Figure 7.10. 

 

Figure 7.10  Unplug the CAN cable 

 

 Loosen the two M3*6 hexagon socket head cap screws from the I/O fixing plate, 

as shown in Figure 7.11. 
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Figure 7.11  Remove the I/O fixing plate 

 

 Mount the I/O fixing plate and the adapter plate with two M3*10 hexagon 

socket head cap screws, as shown in Figure 7.12. 

 

Figure 7.12  Fix the I/O fixing plate and the adapter plate 
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 Plug the CAN cable, as shown in Figure 7.13. 

 

Figure 7.13  Plug the CAN cable 

 

 Bind the battery and battery holder together with two zip-ties, as shown in 

Figure 7.14. 

 

Figure 7.14  Bind the battery and battery holder 

 

 Fix the battery holder to the adapter plate with two M3*6 hexagon socket head 

cap screws, as shown in Figure 7.15.  
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Figure 7.15  Fix the battery holder 

 

  (Optional) If the battery adapter cable is not connected to the battery interface 

on the Driver Board, please connect them, as shown in Figure 7.16. If it has 

been connected, please skip this step. 

 

Figure 7.16  Connect the battery adapter cable and the battery interface 

 

NOTE 

There are two battery interfaces on the Driver Board, as shown in the red box of Figure 
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7.17. You need to connect the battery adapter to the unused battery interface. 

 

 

Figure 7.17  Battery interfaces on the Driver Board 

 

 

 Connect the battery connector to the other end of the battery adapter cable, as 

shown in Figure 7.18. 
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Figure 7.18  Connect the battery connector and battery adapter cable 

 

 Re-install the forearm cover. 

The battery replacement is completed. 
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Figure 7.19  Initial Encoder 

 

 

 

NOTICE 

Please DO NOT click  during the homing procedure, to avoid homing procedure 

failure.  

 

 J3 moves to the upper limit with a signal triggered by the homing switch, and 

moves backward at low speed to separate from the homing switch, and then stops 

moving. 

 J1 and J2 move to the limit as lefty hand orientation with signals triggered by 

homing switches of J1 and J2, and move backward at low speed to separate from 

the homing switches, and then stop moving, indicating that the Dobot M1 has 

moved to the homing point. 

 

Now, you have finished the battery change, and can run Dobot M1 normally. 
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7.3.1.3 Remove Original Battery 

The battery is located on the main controller of the base or on the Forearm. The position of the 

battery depends on the production batch of Dobot M1.  

Procedure 

 

 

 

NOTE 

 If the SN number of Dobot M1 is earlier than DT2118xxxxx, the Encoder battery is 

located on the base of the Dobot M1. If the SN number of Dobsot M1 is 

DT2118xxxxx and later numbers, the Encoder battery is located on the Forearm of 

the Dobot M1. Please check the SN number on the M1Studio > Help > About 

M1Studio page. 

xxxxx is the random number, please replace it based on site requirements. 

 If the SN number is DT2118xxxxx but the encoder battery is not located on the 

Forearm, the battery must be located on the base. 

 If the battery is located on the base, please perform the following steps. 

 Loosen the four screws on the interface board of the base using a 2.5# hexagonal 

wrench, as shown in Figure 7.20. 

 

Figure 7.20  Interface board of the base 

 

NOTE 

The appearance of the interface board depends on the production batch of Dobot M1. 
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However, the replacement method remains unchanged. 

 

 Remove the main controller from the base. 

Please remove the main controller lightly to prevent disconnection between the 

main controller and the robotic arm. 

 Remove the original battery. 

NOTE 

After removing the battery from the main controller on the base, you need to install the 

battery to be replaced on the Forearm instead of the base. For details, please see 

7.3.1.2Replacing Encoder Battery. 

 

 If a fuse is installed on the battery, please cut off the zip-tie that fixed the original 

battery, as shown in Figure 7.21. Remove the battery from the battery holder and 

disconnect the connector of the original battery from the battery adapter cable, as 

shown in Figure 7.22. 

After removing the original battery, please wrap the connector of the battery adapter 

with insulating tape to prevent short circuit. 

 

Figure 7.21  Location of the battery holder 
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Figure 7.22  Disconnect the connector of the battery from the battery adaptor cable 

 

 If a fuse is not installed on the battery, please remove the cover of the battery holder 

to take out the original battery and unplug the battery connector of bus cable 

connecting to the battery holder, as shown in Figure 7.23. 

After removing the original battery, please wrap the battery connector of the bus 

cable with insulating tape to prevent short circuit. 

 

Figure 7.23  Connection between the battery and robotic arm 

 Put the main controller into the base, and fix the interface board. 
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 If the battery is located on Forearm, please perform the following steps. 

 Remove the Forearm cover with 2.5mm hexagon wrench and cross head screw-

driver. 

 Cut off the zip-tie that fixed the original battery, as shown in Figure 7.24. 

 

Figure 7.24  Location of battery holder on Forearm 

 

 Remove the original battery and disconnect the connector of the battery from 

the battery adapter cable, as shown in Figure 7.25. 



                     Dobot M1 User Guide 7 Maintenance 

 Issue V1.5.3 (2020-01-16) User Guide Copyright © Yuejiang Technology Co., Ltd 

154 

 

Figure 7.25  Disconnect the battery from the battery adapter 

 Calibration 

In real applications, the high absolute precision of the robotic arm is required. The origin 

(400,0,0,0) has been set by default, the Dobot M1 can be directly put in use. After parts (motors, 

reduction gear units, battery, etc.) have been replaced or the robotic arm has hit the workpiece, 

the origin of Dobot M1 will be changed. You need to reset the origin. When the Dobot M1 

moves with different arm orientation, the high precision of J2 is required. Therefore, after 

resetting the origin, you need to calibrate J2 to improve the absolute precision. 

Generally, before and after switching the arm orientation at the same point, the J2 

coordinates are axisymmetric. After resetting the origin, the J2 coordinates may become non-

axisymmetric, resulting in that the Dobot M1 cannot move to the same point with different arm 

orientation when implementing playback. It is necessary to make the J2 coordinates 

axisymmetric by compensating the joint angle of J2 to improve the absolute precision after 

resetting the origin. So that the Dobot M1 can move to the same point with different arm 

orientation when implementing playback. 

Prerequisites 

 The Dobot M1 has been powered on. 

 The Dobot M1 has been connected to the PC successfully. 

 The Dobot M1 has been connected to the emergency stop switch. 

 The pen holder kit has been installed on the end of the Dobot M1. The size of the pen 
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holder should be match with the size of the end of the Dobot M1. For details, please see 3.3 

(Optional) Installing End Effector. 

 Please prepare an A4 sheet of paper, and draw a small dot as a calibrated point, as shown 

in Figure 7.26. 

 

Figure 7.26  Calibration point 

 

Procedure 

 

 

The M1Studio tool page is displayed. 

 

If Connect turns to Disconnect, the connection is successful, and the Dobot M1 can 

be controlled by M1Studio. 

 

 

Move the Dobot M1 with righty hand orientation to touch the calibrated point that is 

on the A4 sheet of paper, as shown in Figure 7.27. 
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Figure 7.27  Calibration as righty hand orientation 

 

 

The value of P1 is J2 coordinate with righty hand orientation, as shown in Figure 

7.28. 
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Figure 7.28  Save J2 coordinate with righty hand orientation 
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Figure 7.29  Calibration with lefty hand orientation 

 

 

The value of P2 is J2 coordinate with lefty hand orientation, as shown in Figure 7.30. 
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Figure 7.30  Calibration as lefty hand orientation 

 

 

NOTICE 

After saving P1 and P2, you cannot click Confirm until the motor of Dobot M1 is in the 

enabled state. 

 

 

DANGER 

The Dobot M1 starts to work after clicking Confirm. Please do not enter the workspace 

of the robotic arm, otherwise, it will be vulnerable to injury the device or the person. 
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